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ABSTRACT

PROCESS SIMULATION FOR ROOM TEMPERATURE FORMING OF
SUPERALLOY SHEETS
Durmazkeser, Yunus

M.S., Manufacturing Engineering Department
Supervisor: Asst. Prof. Dr. Celalettin Karadoğan
Co-Supervisor: Asst. Prof. Dr. Omer Music
May 2016, 134 pages

Sheet metal forming processes are extensively used in the aviation industry for the
production of gas turbine parts such as combustion chambers, exhaust nozzles,
sumping assemblies and various hot section elemets. The success of sheet metal
forming processes is determined by the process parameters such as die geometries
and material properties of sheet metal and auxiliary die equipment. Determination of
the optimum inputs by trial and error is a costly and time consuming approach,
therefore implementation of finite element analysis has been an inevitable
requirement.

This paper aims to form a guideline for the preparation of finite element model
(FEM) in LS-DYNA® for most frequently used sheet metal forming processes at
TEI-TUSAŞ such as deep drawing, rubber pad forming, and segmented radial
expansion process. For that purpose, material information and boundary conditions
are modeled as accurately as possible. Experimentally determined material data of
iii

aerospace superalloys (Hastelloy x, Inconel 718, Rene 41, and Waspaloy) are
employed to establish material database for the model. Furthermore, anisotropy
behaviour of superalloy sheet materials are defined inside the software. Software also
lets user to define flow curve of specific materials as stress-strain graph. Using these
information, numerical simulation of the manufacturing processes are constructed by
finite element modeling software for basic sheet metal forming process, which are;
deep drawing, expanding, and rubber pad forming.
Keywords: Sheet metal forming, finite element analyses (FEA), deep drawing, LSDYNA®, rubber pad forming, segmented radial expansion process, superalloys
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ÖZ

SÜPERALAŞIM SAC MALZEMELERİN SOĞUK ŞEKİLLENDİRMESİ
İÇİN SÜREÇ SİMÜLASYONU
Durmazkeser, Yunus

Yüksek Lisans, İmalat Mühendisliği Bölümü
Tez Yöneticisi: Yrd. Doç. Dr. Celalettin Karadoğan
Ortak Tez Yöneticisi: Yrd. Doç. Dr. Omer Music
Mayıs 2016, 134 sayfa

Sac şekillendirme süreçleri havacılık sektöründe yanma odası, egzoz nozulları,
sızdırmazlık elemanları gibi gaz türbin parçalarının ve yüksek sıcaklıkta çalışan çok
sayıda elemanın imalatında yaygın olarak kullanılır. Söz konusu süreçlerin başarısı,
kalıp geometrisi, sac malzeme ve yardımcı kalıp ekipmanlarına ait malzeme
özellikleri gibi proses parametreleri tarafından belirlenir. Optimum parametrelerin
deneme-yanılma yolu ile belirlenmesi yüksek maliyet gerektiren ve zaman alan bir
yaklaşımdır, bu sebeple sonlu eleman analizlerinin kullanımı kaçınılmaz bir ihtiyaç
olmuştur.
Bu çalışma; TEI-TUSAŞ’ta yaygın olarak uygulanan derin çekme, kauçuk ile
şekillendirme ve ekspend gibi en sık kullanılan sac metal şekillendirme süreçlerinin
LS-DYNA®’da sonlu eleman modellerinin (SEM) doğru olarak hazırlanmasına
yardımcı olacak bir kılavuz oluşturmayı hedeflemektedir. Bu amaçla, malzeme
bilgisi ve sınır koşulları mümkün olan en doğru şekilde modellenmştir. Havacılık
v

süperalaşımlarına (Hastelloy x, Inconel 718, Rene 41 ve Waspaloy) ait deneysel
olarak belirlenmiş malzeme verileri, malzeme veritabanı oluşturmak için
kullanılmıştır. Bununla birlikte, süperalaşım sac malzemelerin anizotropi davranışları
yazılımda tanımlanmıştır. Ayrıca yazılım, özel malzemelerin akma eğrilerinin
gerilme-şekil değiştirme grafiği olarak kullanıcı tarafından tanımlanmasına olanak
sağlamaktadır. Sözkonusu girdilerin kullanılması ile temel sac şekillendirme
süreçleri olan derin çekme, radyal dilimli ekspend ve poliüretan kauçuk malzeme ile
şekillendirme süreçlerinin nümerik modelleri sonlu eleman modelleme yazılımı
tarafından oluşturulmuştur.

Anahtar Kelimeler: Sac şekillendirme, sonlu eleman analizleri (SEA), derin çekme,
LS-DYNA, kauçuk ile form verme, radyal dilimli ekspend prosesi, süperalaşımlar
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CHAPTER 1
INTRODUCTION
1.1 Materials
The materials used in aircraft structures require a combination of high stiffness,
strength, fracture toughness, fatigue endurance and corrosion resistance. Aerospace
materials must carry the structural and aerodynamic loads while being inexpensive
and easy to fabricate. The materials must also be damage tolerant and provide
durability over the aircraft design life, which for large commercial airliners is 30
000–60 000 flight hours (25–30 years). During this period, the aircraft structures
should not crack, corrode, oxidise or suffer other forms of damage while operating
under adverse conditions that involve high loads, freezing and high temperatures,
lightning strikes and hail impact, and exposure to potentially corrosive fluids such as
jet fuel, lubricants and paint strippers [1].
When the inner structure of jet engines are investigated, the number of parts
constituting the assembly is striking. For instance, a standart Boeing 747 engine
contains almost 25,000 parts. On the other hand, the material of the assembly is not
so diverse, since the harsh operating conditions of jet engines are not suitable for
standart materials. Superalloys have excellent heat-resistance owing to its
constituents iron, nickel, and cobalt. This attribute makes superalloys durable in
demanding environment involving high stress and extreme temperature. Superalloys
possess high strength, creep and oxidation resistance, and long fatigue life at high
temperature. The hot sections of the jet engine can reach ~1300 ˚C. Superalloys are
appropriate for hot sections and especially for combustion chambers, since they can
function between 950 and 1300 ˚C for long periods preserving their spectacular
properties. Since 1950s, reaching high performance has been the driving force to
develop the designs of jet engines. Although preliminary designs of aircrafts did not
need superalloys, they could not reach high speeds due to the limited power
generation. The most effective solution to increase the power generation of jet
engines is to increase the temperature of the operating environment. With their
outstanding reliability, superalloys have been vital in the evolution of jet aircraft
technology [2,3].
1

Figure 1: Tensile Strength of Some Superalloys As A Function of Temperature [3]

In terms of the raw material value, superalloys have 17% share in aerospace raw
material market (Figure 2) which makes superalloys third after aluminum alloys and
titanium alloys. On the other hand, the share declines to 9% in the pie chart that
compares materials in terms of weight (Figure 3) [4].

Figure 2: Total Aerospace Raw Material Market [4]

2

Figure 3: Total Aerospace Material Demand [4]
A comparison between the prices of superalloys and 316 grade stainless steel sheet is
shown in Table 1. The enormous gap between the steel and superalloys prices
necessitate the usage of analytical solution procedures instead of trial and error
approaches especially for aviation companies that process superalloys from raw
material.
Table 1: Sheet Metal Prices
Material
Inconel 718
Hastelloy X
Waspaloy
Rene 41
316 SS

Unit Price ($/lb)
32,56
29,59
114,70
122,63
1,92

Nowadays, the most effective solution method to estimate the success of a sheet
metal forming process is to perform finite element analysis. Although this method
has been used primarily by universities, the companies have started adapting this
very self-proven technique with a variety of finite element programs. LS-DYNA ®,
ANSYS ®, Simufact ®, DYNAFORM ® are amongst the most extensively used
softwares. LS-DYNA® is one of the most advantageous ones, since material
properties can be defined as accurately as possible. Namely, considering the other
finite element softwares, anisotropic properties (direction dependency) can only be
3

defined using LS-DYNA®. This attribute of the program outshines the other
softwares in terms of precision. Moreover, a process, irrespective of its complexity,
can be simulated in a single file with LS-DYNA®. The program has some
drawbacks such as limited mesh manipulation and shortcoming related to user
interface: lots of commands cannot be undone.
There are a number of steps that must be accounted for process simulation. The study
presented in this thesis aims at forming a guideline in order to simulate most
common superalloy sheet behaviours at room temperature forming processes. For
simulating material behaviours, the results of study proposed by Ertan [5] was
employed. The data obtained from material characterization tests was adapted into
LS-DYNA software. Case studies for deep drawing, rubber forming, and radial
expansion processes were performed for nickel based aerospace superalloys:
Hastelloy x, Inconel 718, and Waspaloy.

4

CHAPTER 2
LITERATURE SURVEY
2.1 Introduction to Metal Forming
Among numerous manufacturing methods, sheet metal forming takes place under
shaping and deformation methods (Figure 4).

Figure 4: Manufacturing Processes [6]

According to Tschaetsch, deformation methods can be classified in five groups
(Figure 5)[7]:
-

Forming by pressure

-

Tensile/compressive forming

-

Forming by tensile forces

-

Forming by bending

-

Forming by shearing

5

Figure 5: Deformation Methods [7]

Deformation methods form the base of this study. This thesis focuses on numerical
optimization studies of expanding, deep drawing, and rubber pad forming processes
since
The manufacturing of deformation dies is expensive
Material is expensive
Process design should be robust
Conventional trial and error methods to obtain targeted geometry are
insufficient
High accuracy and fast solutions can only be succeeded by employing
numerical methods and finite element analysis approaches

In this chapter, detailed information is given about deep drawing, and rubber pad
forming, and expanding processes.
6

2.2 Rubber Pad Forming
Rubber pad forming process is usually executed on press machines. For this process,
a pad made of rubber or polyurethane is placed on the piston of the press. Then, a
block is positioned on the flat plate. Block can be designed as a punch of a
conventional die, or as a female die. Elasto-plastic material property of rubber,
enables it to behave as a hydraulic fluid applying pressure on all surfaces of the sheet
metal to be shaped. The benefits of the rubber pad forming processes are [8]:
Rubber pad can be pressurized to have a variety of geometries. When the
pressure is removed, it can return back to its original shape easily.
Tooling is easier and cheaper to obtain, compared to conventional forming
tools.
Thickness reduction of sheet metal is not extreme and not localized.
The drawbacks of rubber pad forming process are:
Wearing of pad is quick, starting from the sharp edges. A rubber or
polyurethane pad can be used 20,000 times on average.
Applied pressure is lower with respect to conventional forming processes.
Therefore, geometries having sharp transitions are more difficult to obtain.
The most commonly used rubber pad forming process is the Guerin process. There is
no special equipment requirement, because a hydraulic press machine can be
converted to a Guerin press. The capacity of the machine and pad geometry are
primary constraints for this process [8].
Rubber pad and a form block are needed equipment for this process (Figure 6).
Rubber part is generally made of polyurethane and therefore it is a soft material. By
means of deformable, compressible, and elastic nature of rubber, the pad to be used
can consist of one or more parts. Suggested retainer material is cast iron to resist
forces generated. Recommended pad thickness is between 200 to 230 mm. Block
materials can be selected as steel, wood, alloys of magnesium or bismuth [8].

7

Figure 6: Tooling and Setup For Rubber-Pad Forming By The Guerin Process [8]

2.3 Deep Drawing
Deep drawing process is preferred to manufacture a lot of products such as pressure
vessels, zinc cell, and utensils. Additionally, aviation and automotive industry is
highly dependent on deep drawing process. The process is illustrated in Figure 7.
Deep drawing process can be investigated looking at flange and wall. Wall is the
supporting unit for the force, because the shaping of metal is achieved by deforming
the flange zone. Large blank diameters are not recommended, since the stress
imposed on the wall can surpass its strength and cause failure.
Material formability is designated by limiting drawing ratio (LDR). This parameter is
calculated by dividing the initial maximum blank diameter (d0) to final cup diameter
without a flange (d1). In this respect deep drawing is similar to wire drawing. Indirect
compression is induced by tensile forces in the drawn material. Each element in the
flange must undergo enough circumferential compression to permit it to flow over
the die lip. A typical drawing failure is shown in Figure 8. The flanges must be held
down to prevent wrinkling. Figure 9 shows what happens when the hold-down force
is insufficient [9].
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Figure 7: Illustration of Cupping and Coordinate Axes [9]

Figure 8: Drawing Failures By Necking At The Bottom of The Cup Wall [9]

Figure 9: Wrinkling of Partially Drawn Cups Due To Insufficient Hold-Down [9]

The following analysis, is constructed on the coordinate system shown in Figure 10.
The assumptions to simplify the solution process are as follows:
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Figure 10: A Partially Deep Drawn Cup [9]

1. Energy is consumed completely in order to deform the flange material. The
energy used for friction and bending are neglected.
2. Strain hardening is neglected.
3. Plane strain is assumed for the flange. εz = 0, therefore the wall thickness
remains unchanged [9].

Plane strain assumption in the flange stipulates a constant total surface area. At the
same time, the surface area inside an element does not change. Therefore,
πρ2 + 2πr1h = πρ02

(1)

2πρdρ + 2πr1dh = 0

(2)

dρ = -r1dh/ρ

(3)

Circumferential strain is calculated as dεy = dρ/ρ. dεz = 0, therefore,
dεx = -dεy = -dρ/ρ = r1 dh/ρ2

(4)

where, infinitesimal punch motion is dh. The infinitesimal work on an annular
element is calculated by multiplication of element volume (2πtρ dρ) and infinitesimal
work (σx dεx + σy dεy + σz dεz = (σx − σy) dεx). Total infinitesimal work is calculated as
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dW = (2πtρ dρ)(σx − σy)(r1/ρ2)dh

(5)

(σx − σy) is constant value and can be shown as σf. The total work is calculated from

dW
dh

r

2 rt
1

f

d

2 rt
1

f

ln

r1

r
r1

(6)

The drawing force Fd, which equals dW/dh, has its largest value at the beginning of
the draw when r = r0, so
Fd(max) = 2πr1tσfln(d0/d1),

(7)

where d0 and d1 are diameters of the blank and cup.

The axial stress that the wall must carry is then

Fd (max)
x

f

2 rt
1

ln(d0 / d1 )

(8)

The wall will begin to neck when σx = σw, the yield strength of the wall, or

σw = σf ln(d0/d1 )

(9)

Both σw and σf are plane-strain yield strengths. They are equal for an isotropic
material, so equation predicts that LDR = exp(1) = 2.72. This value is too high. The
development should be modified by realizing that the calculated work in the flange
and hence the calculated drawing force should be multiplied by 1/η to account for the
work against friction and the work to cause bending. In this case LDR = exp(η).
Usually the LDR is about 2, so the efficiency is about 0.70 [9].
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2.4 Expanding
Expanding is a sheet metal forming process based on radial enlargement of sheet
metals using independent moving segments. Expanding machines or expanders are
generally constructed customly and depend highly on hydraulic systems. Expanders
have inner cylinder that can be moved in vertical direction. The conical shape of the
cylinder allows the segments to move radially in horizontal plane. Depending on the
geometry of the part to be expanded, segment geometry is determined. Figure 11
shows a typical expander that has a capacity of 3000 psi.

Figure 11: Expander Machine [10]
The sheet metal to be expanded is rolled and welded from edges to construct a
cylinder. Then, the diameter of the cylinder is enlarged by the mobile segments. The
process steps are illustrated in Figure 12. The cylinder of the machine is positioned at
the top before the process. The segments (Item 1), cylindrical sheet metal (Item 2),
and outer die (Item 3) are located as shown. As the cylinder is pressed downwards,
slices of the machines starts moving radially outwards and contacts segments (Item
1). Then, segments move and push the sheet metal (Item 2). Sheet metal enlarges
until it contacts outer die (Item 3). Outer die consists of one part and resists the
forces applied by the machine and the segments – Outer die is stationary, and it is
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known as stopper as well. The resistance of stopper (Item 3) causes the sheet metal to
be suppressed between stopper and the segments. When the process is completed and
the sheet metal is formed, the cylinder of the machine is pulled upwards. Thus, the
force on the segments are eliminated.

Figure 12: Expand Process - Section View
The segment geometry is part specific and can be designed and manufactured
according to final shape. Generally, the segments are produced first by turning the
tool material to desired profile geometry, then using electrical discharge machining
(edm) method, the material is divided into equal independent segments. The number
13

of segment depends highly on stroke of the machine, since the material quantity to be
machined by edm is affected directly by the motion of the segments.

Figure 13: Segment Motion (Top View)
The distance between the segments increases as the process continues. Because of
increasing distance between the segments, segments may not contact sheet metal at
intermediate zones. As a result, the part cannot be shaped completely. The remedy to
this case is to pause the process and then rotate the sheet metal at some intervals.
Thus, noncontacting regions can be eliminated.
2.5 Mechanics of Sheet Metal Forming
The amount of deformation of an object is formulated by strain. Under the effect of
loads, each point on the surface and inside the object are affected and some of them
are relocated. Determination of strain correctly requires elimination of translational
and rotational components of the motion. A deformed line is illustrated in Figure 14.
The line snippet experience the effects of translation, rotation and deformation. Axial
deformation is dictated by engineering strain, e [9]:
e

(l l0 ) / l0

l / l0

(10)

True strain, ε, is defined by

d

dl / l
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(11)

ln(l / l0 )

ln(1 e)

(12)

Figure 14: Deformation, Translation, and Rotation of A Line Segment

Variations in atomic arrangements and internal structures of metals causes them to
show direction dependent properties, or anisotrpy. Apart from nature of the
materials, sheet metals are also influenced by intermediate processes such as rolling.
Rolling of a sheet metal leads to a specific type of anisotropy: orthotropy. Orthotropy
can be expressed as the symmetry behaviour of mechanical properties with respect to
three orthogonal planes. Orthotropy axes are the intersection lines of the symmetry
planes. Figure 15 shows the orientation of orthotropy axes. RD, TD and ND stands
for rolling direction, transverse direction, and normal direction, respectively [11].

Figure 15: Orthotrophy Axes of The Rolled Sheet Metals [11]

Plastic behaviour is a material property and changes with the direction. This feature
is formulated as anisotropy coefficient. The anisotropy coefficient of a sample can be
measured by performing tensile tests and it is calculated with the following formula:
22

r

(13)
33
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ε22 is the strain in the width direction, and ε33 is the strain in the thickness direction.
Isotropic materials have the same strain values in width and thickness directions,
therefore, it is calculated as one. For the cases where width strains are bigger than
thickness strains, anisotropy coefficient is found to be more than one. On the other
hand, if the thickness strains are bigger than width strains, anisotropy coefficient is
less than one [11].
The previous equation can be developed to include initial width w0, final width w,
initial thickness t0 and final thickness t of the sample
w
w0
t
ln
t0

ln
r

(14)

For sheet metal forming processes, measurement errors related to the sample
thickness are negligible considering the width of the sample. To eliminate the effects
of probable uncertainties, the denominator should be reformulated. Volume is
constant during a forming process, therefore,
ε11 + ε22 + ε33 = 0

(15)

the following equations are obtained
22

r

(16)
11

ln
r
ln

l
l0

22

w
w0
ln

w
w0

(17)

l0 is the initial length and l is the final length of the specimen. Finally, the equation of
anisotropy coefficient is transformed into the following form [11]:
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w
w0
l .w
ln 0 o
l.w
ln

r

(18)

2.6 Failure
Metal forming operations have restrictions and limits determined by the material
properties, processing conditions, geometry, and the tooling. Since each process has
some unique characters, determination of process limits might not be
straightforward. The following are the most common defects frequently encountered
in manufacturing processes and especially in the sheet metal forming practices.
• Inability of the sheet to transmit the required force. In a cup drawing process,
endurance of cup walls is critical considering the force needed to move the flange
inward. If the yield limit of cup wall is exceeded, a catastrophic and global instability
occurs. The increase in the punch force is the main reason to trigger the peripheral
tension.
• Localized necking or tearing. Local neck formation is one of the primary causes of
tearing in sheet metal forming processes. Although this is a local instability case, the
process is terminated due to growing zone of defect and should be considered during
design step.
• Fracture. This phenomenon is not commonly encountered for sheet metal forming
processes. However, according to the degree of the plastic deformation, brittle
fracture can be observed.
• Wrinkling. Besides tensile forces, compressive forces exist in sheet metals. This
condition can cause buckling or wrinkling of the blank.
In industrial applications, forming presses are designed as displacement controlled.
Therefore, the motion of the punch is driven by the mechanism. If the punch force or
load is not monitored during processing, it is probable to observe failures [12].
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Detection of global instabilities in deep drawing processes requires an analysis of the
entire process. The analysis of local instabilities can be performed by investigating
faulty elements. Even though the local necking is generally related to tension, some
circumstances show that there are other causes of catastrophic failures [12].
2.7 Previous Studies On Modeling of Forming Processes
This study focuses on finite element modeling of rubber pad forming, deep drawing,
and diameter expansion operations in which the material is shaped and formed with
the vertical movement of die and with the help of polyurethane. Studies which are
directly related with the aforementioned operations include applications of finite
element analyses and springback prediction methods for the process focusing on
modeling optimization of the process.
Madoliat et al. [13] investigated rubber pad forming process to find a computer
model which is able to simulate the process and therefore to find the right design for
the tooling set. During experiments, they noticed that the same rubber with no
changes in dimensions can be used for a vast variety of parts in the same size range.
They used finite element method to predict both rubber and blank behavior during
the process.
Benisa et al. [14] developed a numerical model that would be able to successfully
simulate a rubber pad forming process. They used finite element method for blank
and
rubber behavior predictions during the process. The study was concerned with a
simulation and investigation of significant parameters associated with the rubber-pad
forming process and the capabilities of this process regarding the manufacturing of
aircraft wing ribs. Experimental analyses of a rib with a lightening hole showed a
good correlation between finite element simulations and experimental results.
Deladi [15] developed a static friction model and applied it to a rubber pad forming
process. The model enabled to obtain curvefits for the static friction force and
limiting displacement as a function of various parameters. These curve-fits are
further used as static friction model in a finite element simulation of the rubber pad
forming process.
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In another study, the rubber pad forming process of an aluminum aeronautic
component has been explored with numerical simulations and the significant
parameters associated with this process have been investigated. Several effects,
related to stamping strategy, part geometry and rubber pad characterization have
been taken into account. The process analysis has been carried out employing a finite
element package useful for an appropriate set-up of the process model. The
investigation have shown the effectiveness of simulations in process design and
highlighted the critical parameters which require necessary corrections before
experimental studies [16].
The effective factors in the rubber forming method on components containing
curvature radius, have been investigated by finite element method by Mahshidifar
and Vafaeesefat [17]. The effect of variables such as curvature radius, sheet
thickness, rubber pad thickness, and spring back phenomena have been analyzed. To
validate the finite elements simulation, the results of physical tests were compared.
Ramezani et al. [18] presented theoretical static and kinetic friction models for an
axisymmetric rubber-pad forming process. Both models are based on the local
contact conditions. Furthermore, rubber forming experiments and simulations were
performed. The predicted friction curves using the new friction models were
implemented in the finite element code ABAQUS. From the results of simulations it
was found that the new friction models have better correlation with experimental
results compared to traditional Coulomb friction model.
Wozniak et al. [19] studied results of computer simulations supporting production
process of bearing housing of gas turbine. Verification of both deep drawing process
and tools design were carried out using finite element models implemented in
Dynaform and LS-DYNA solver. Wrinkling and fracture of the material were the
main phenomena to be investigated using numerical analysis methods. A number of
computer simulations were carried out in order to analyze the deformation and strain
distribution in the final product, as well as to eliminate the defects that are related to
sheet metal forming processes [19].
Abhishek Kumar and Santosh Kumar [20] carried out simulation of the microchannel for fabrication of pure aluminum bipolar plate. Rubber material of 70 shore
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hardness is used as die. Results indicate that rubber die is capable of sustaining
forming loads and defect free product can be obtained. Thus simulation of rubber pad
forming process is verified using ABAQUS with encouraging results. The study also
shows that process can be extended for complicated shapes.
Adamus and Lacki [21] investigated sheet-titanium forming using flexible tool. To
improve sheet formability, forming technology using a semi-flexible tool was
implemented. Experiments were carried out on a specially designed device. Due to
the forces applied by rubber pad the stress state similar to triaxial compression was
produced in the deformed material. Such a stress state made it possible to obtain
higher material deformation without risk of fracture. The numerical simulations were
used in order to analyze the flexible forming process.
Yang [22] used FEM software DEFORM-3D to simulate the elliptic cup deep
drawing of pure magnesium metal sheet at elevated temperatures. He used finite
element method to investigate the effective stress distribution and maximum forming
load under various process parameter conditions, including the profile radius of die,
the clearance between die cavity and punch and the blank holding force.
Furthermore, in order to form a uniform cup height of products, a reverse forming
method for obtaining initial blank’s shape according to the forward square cup
drawing simulation is proposed.
In the study of Anwekar and Jain [23], the single stage deep drawing process of thin
walled, mild steel, conical back plate of radial impeller of blowers is approached by
means of a finite element analysis. They studied the simulation of the drawing
process for determining stress distribution in the drawn component for a
predetermined displacement. The distribution of stress in the drawn component is
obtained using ANSYS.
Anaraki et al. [24] presented multi-stage deep drawing simulation of an industrial
part using finite element method. The entire production steps including springback
has been simulated by ABAQUS software under axisymmetric conditions. The
simulation results such as sheet thickness distribution, punch force and residual
stresses have been extracted in any stages. Also sheet thickness distribution was
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compared with experimental results. It was found through comparison of results, the
FE model have proven to be in close agreement with those of experiment.
Dahham et al. [25] predicted the wrinkling and thinning failure and studied the effect
of draw beads on the thickness distribution along the cup. In their study, they
targeted to analyze the deep drawing process using draw beads. The best results and
the low variation between the maximum thickness and minimum thickness are
obtained at the half circle shapes of draw bead.
In his investigation, Yang [26] focused on the deep drawing process of magnesium
alloy sheet. He employed the FEM software DEFORM-3D to investigate the material
flow character during the elliptic cup deep drawing of magnesium alloy sheet at
elevated temperatures. He investigated the effective stress and forming load under
various process parameter conditions, including the profile radius of die, the
clearance between die cavity and punch, the blank holding force and working
temperature during the elliptic cup deep drawing of magnesium AZ31 alloy sheet.
Ayari and Bayraktar [27] developed a parametric study that leads mainly to predict
accurately the final geometry of the sheet blank and the distribution of strains and
stresses and also to control various forming defects, such as thinning as well as
parameters affecting strongly the final form of the sheet after forming process. They
conducted a validation study of the FEM model. They built a 3D parametric FEA
model using Abaqus /Explicit standard code. Several elastic plastic materials were
used in the FEA model and then, they were validated via experimental results.
Kishor and Kumar [28] studied deep drawing of highly anisotropic sheets. In their
work, an attempt has been made to study earing problem in deep drawing of
cylindrical cups using a flat bottom punch from extra-deep drawing steel sheets using
LSDYNA. The mechanical properties and the formability parameters of the sheets
were determined from the simple tensile tests. These properties along with
experimental design parameters were used as input for simulation of deep drawing.
Significant earing was observed and it compared with experimentally determined
earing with reasonably good accuracy.
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The study presented here is similar to the previous works in terms of investigated
processes: deep drawing and rubber pad forming processes and in terms of finite
element approach. However, scientific resources for sheet metal forming processes
do not emphasize expanding process as a separate manufacturing method. In this
regard, this thesis details a process that has not been referred previously.
Furthermore, as a continuation of the thesis of Ertan [5], material properties of
superalloys, which do not exist in literature, have been detected experimentally and
employed to simulate material models. Another novelty presented in the thesis is the
illustration of a systematic approach to demonstrate all compulsory steps and to
prepare a successful process simulation in LS-DYNA®.
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CHAPTER 3
MODELING WITH LS-DYNA
3.1 Introduction To LS-DYNA
LS-DYNA is a general-purpose finite element program capable of simulating
complex real world problems. It is used by the automobile, aerospace, construction,
military, manufacturing, and bioengineering industries. The code's origins lie in
highly nonlinear, transient dynamic finite element analysis using explicit time
integration.
"Nonlinear" means at least one of the following complications:
Changing boundary conditions (such as contact between parts that changes over
time)
Large deformations (for example the crumpling of sheet metal parts)
Nonlinear materials that do not exhibit ideally elastic behavior (for example
thermoplastic polymers)

"Transient dynamic" means analyzing high speed, short duration events where
inertial forces are important. Typical uses include:
Automotive crash (deformation of chassis, airbag inflation, seatbelt tensioning)
Explosions (underwater Naval mine, shaped charges)
Manufacturing (sheet metal stamping)

LS-DYNA® consists of a single executable file and is entirely command line driven.
Therefore all that is required to run LS-DYNA® is a command shell, the executable,
an input file, and enough free disk space to run the calculation. All input files are in
simple ASCII format and thus can be prepared using any text editor. Input files can
also be prepared with the aid of a graphical preprocessor.
There are many third party software products available for preprocessing LS-DYNA
input files. LSTC also develops its own preprocessor, LS-PrePost, which is freely
distributed and runs without a license. Licensees of LS-DYNA automatically have
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access to all of the program's capabilities, from simple linear static mechanical
analysis up to advanced thermal and flow solving methods.

3.2 LS-DYNA Keyword Definitions
To construct a model in LS-DYNA, the rationale of using keywords must be known.
Selection of suitable keywords is dependent on the type of the application, boundary
conditions, and material properties. Considering the available vast keyword pool, it
is a cumbersome task to decide the most efficient keyword combinations for a typical
sheet metal forming simulation. Therefore, this document aims to present the most
effective keyword combinations for a sheet metal forming model.

3.3 Necessary Cards for the Simulation of Considered Processes
LS-DYNA contains innumerous cards (keywords) to construct a model. Since the
sofware is designed for lots of engineering branches, it is difficult to detect the cards
that are required for thermal analysis, acoustics, fluid dynamics, or sheet metal
forming. Therefore, for the beginning, it might be perplexing to decide on the correct
keyword combinations for a specific process modeling. The required keywords for
sheet metal forming models are shown in Figure 16.
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Figure 16: Necessary Cards For Simulation

The diagram is a summary of the keywords that is needed to construct a simulation.
The black keywords are always employed and therefore they are compulsory. On the
other hand, the blue keywords are needed for specific applications or in order to
increase the accuracy of the model. Their requirements are determined according to
process to be modeled.
*BOUNDARY is a keyword that applies to various methods of specifying either
fixed or prescribed boundary conditions. It provides a way of defining imposed
motions on boundary nodes. The keyword control cards in this section are defined in
Table-2

Table 2: Relevant Cards For Boundary Control
*BOUNDARY_PRESCRIBED_MOTION_{OPTION1} _{OPTION2}
*BOUNDARY_SPC_{OPTION1}_{OPTION2}_{OPTION3}
*BOUNDARY_PRESCRIBED_MOTION_OPTION1_{OPTION2} defines an
imposed nodal motion (velocity, acceleration, or displacement) on a node or a set of
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nodes. Also velocities and displacements can be imposed on rigid bodies. If the local
option is active the motion is prescribed with respect to the local coordinate system
for the rigid body. Translational nodal velocity and acceleration specifications for
rigid body nodes are allowed and are applied. For nodes on rigid bodies NODE
option is used. Do not use the NODE option in r-adaptive problems since the node
ID's may change during the adaptive step.
Variable DOF stands for applicable degrees-of-freedom. According to the number
specified, the degree-of-freedom is explained in Table 3.

Figure 17: *BOUNDARY_PRESCRIBED_MOTION
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Table 3: Variable DOF and Available Options
EQ
0
1
2
3

Explanation
No translation or rotation.
x-translational DOF.
y-translational DOF.
z-translational DOF.

10

Translational motion only in direction given by
the VID. Movement on plane normal to the
vector is permitted.
x-rotational DOF.
y-rotational DOF.
z-rotational DOF.
Rotational motion about the vector given by
VID. Rotation about the normal axes is
permitted.
y/z DOF for node rotating about the x-axis at
location (OFFSET1.OFFSET2) in the yz-plane.
point (y.z). Radial motion is NOT permitted.
Same as 9. except radial motion is permitted.
z/x DOF for node rotating about the y-axis at
location (OFFSET1.OFFSET2) in the zx-plane.
point(z.x). Radial motion is NOT permitted.

-10

Same as 10. except radial motion is permitted.

11
-11

x/y DOF for node rotating about the z-axis at
location (OFFSET1.OFFSET2) in the xy-plane.
point (x.y). Radial motion is NOT permitted.
Same as 11. except radial motion is permitted.

4
5
6
7

8

9
-9

When DOF=5, 6, 7, or 8, nodal rotational degrees-of-freedom are prescribed in the
case of deformable nodes (OPTION1=NODE or SET) whereas body rotations are
prescribed in the case of a rigid body (OPTION1=RIGID). In the case of a rigid
body, the axis of prescribed rotation always passes through the body's center of mass.
For |DOF|=8, the axis of the prescribed rotation is parallel to vector VID. To
prescribe a body rotation of a set of deformable nodes, with the axis of rotation
parallel to global axes x, y, or z, one should use OPTION1=SET with |DOF| = 9, 10,
or 11, respectively.
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Variable VAD stands for velocity/acceleration/displacement flag. According to the
number specified, the flag is explained in Table 4.

Table 4: VAD (Velocity/Acceleration/Displacement) Flag
EQ
0
1
2
3
4

Explanation
Velocity(rigid bodies and nodes).
Acceleration(nodes only).
Displacement(rigid bodies and nodes).
Velocity versus displacement(rigid bodies).
Relative displacement(rigid bodies only)

Variable LCID stands for load curve ID to describe motion value versus time. To be
able to use this option, motion should be previously defined as a curve.
Variable SF stands for load curve scale factor. To be able to use this option, motion
should be previously defined as a curve. The load curve scale factor can be used for
simple modifications or unit adjustments.
The activation time, BIRTH, is the time during the solution that the constraint begins
to act. Until this time, the prescribed motion card is ignored. The function value of
the load curves will be evaluated at the offset time given by the difference of the
solution time and BIRTH. Relative displacements that occur prior to reaching BIRTH
are ignored. Only relative displacements that occur after BIRTH are prescribed.
DEATH is the time imposed motion/constraint is removed.
For the cases of restrained nodes of rigid body, translational velocity of mass center
is calculated by
vcm = vnode – w x (xcm – xnode)

(19)

where vcm is the velocity of the mass center, vnode is the velocity of the node, w is the
angular velocity of the rigid body, xcm is the coordinate of the center of mass, and
xnode is the coordinate of the node. Angular velocity of the rigid body is not changed
during this process. Finally, translational motion is obtained. Specifying more than
one motion of rigid bodies is not suggested to avoid unexpected results.
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*CONTACT_OPTION1_{OPTION2}_{OPTION3}_{OPTION4}_{OPTION5}_{O
PTION6} defines a contact interface. OPTION1 specifies the contact type.
OPTION3 specifies that the first card to read defines the heading and ID number of
contact interface and takes the single option: ID. Cards 1 to 3 are mandatory for all
contact types.
SSID is the slave segment, node set ID, part set ID, part ID, or shell element set ID.
Deformable bodies i.e, sheet metal should be chosen as slave segment. MSID is the
master segment set ID, part set ID, part ID, or shell element set ID. SSTYP is the
slave segment set or node set type. The type must correlate with the number specified
for SSID in Table 5.
Table 5: SSID
EQ
0
1
2

Explanation
Segment set ID for surface to surface contact.
Shell element set ID for surface to surface
contact.
Part set ID.

3

Part ID.

4
5
6

Node set ID for node to surface contact.
Include all for single surface definition.
Part set ID for exempted parts.

MSTYP is master segment type. The type must correlate with the number specified
for MSID in Table 6.

Table 6: MSID
EQ
0
1
2

Explanation
Segment set ID for surface to surface contact.
Shell element set ID for surface to surface
contact.
Part set ID.

3

Part ID.

4

Node set ID for node to surface contact.
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FS is the static coefficient of friction. The frictional coefficient is assumed to be
dependent on the relative velocity vrel of the surfaces in contact µc = FD + (FS –
FD)e-DC|vrel|. PENCHK is the small penetration in contact search option. If the slave
node penetrates more than the segment thickness times the factor XPENE, the
penetration is ignored and the slave node is set free. The thickness is taken as the
shell thickness if the segment belongs to a shell element or it is taken as 1/20 of its
shortest diagonal if the segment belongs to a solid element. This option applies to the
surface-to-surface contact algorithms.
The keyword control cards are optional and can be used to change defaults, activate
solution options such as mass scaling, adaptive remeshing, and an implicit solution;
however, it is advisable to define the *CONTROL_TERMINATION card. The
ordering of the control cards in the input file is arbitrary. To avoid ambiguities, one
should define no more than one control card of each type.
*CONTROL_ACCURACY is used to define control parameters that can improve
the accuracy of the calculation.

Figure 18: Keyword *CONTROL_ACCURACY

INN is the invariant node numbering for shell and solid elements. For explicit
analysis, it will be set to 1.

*CONTROL_ADAPSTEP aims to define control parameters for contact interface
force update during each adaptive cycle.
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Figure 19: Keyword *CONTROL_ADAPSTEP
*CONTROL_ADAPTIVE activates adaptive meshing. The parts which are
adaptively meshed are defined by *PART.
ADPFREQ is the time interval between adaptive refinements, see Figure 20.
ADPOPT is the adaptive options (see Table 6 for avaliable list of options).

Table 7: ADOPT Options
EQ

Explanation

7

Angle change in degrees per adaptive refinement
relative to the surrounding elements for each
element to be refined (default).
Total angle change in degrees relative to the
surrounding element for each element to be
refined.
3D r-adaptive remeshing for solid elements.
Solid element type 13. a tetrahedron. and 3D
EFG type 41. are used in the adaptive remeshing
process. A completely new mesh is generated
which is initialized from the old mesh using a
least squares approximation. The mesh size is
currently based on the minimum and maximum
edge lengths defined on the
*CONTROL_REMESHING keyword input.
This option remains under development. and we
are not sure of its reliability on complex
geometries.

8

2D r-adaptive remeshing for axisymmetric and
plane strain solid elements.

1

2
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Figure 20: ADPFREQ

ADPSIZE is the minimum element size to be adapted based on element edge length.
If undefined the edge length limit is ignored.

Figure 21: Keyword *CONTROL_ADPSIZE
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The purpose of CONTROL_CONTACT is to change defaults for computation with
contact surfaces. ISLCHK is the initial penetration check in contact surfaces with
indication of initial penetration in output files. If the value is set to 1, penetration
check is not peformed. If the value is set to 2, full check of initial penetration is
performed. THKCHG is the shell thickness changes considered in single surface
contact. If the value is set to 0, thickness change is not considered. If the value is set
to 1, shell thickness changes are included.

Figure 22: Keyword *CONTROL_CONTACT

*CONTROL_ENERGY provides controls for energy dissipation options. HGEN is
the Hourglass energy calculation option. This option requires significant additional
storage and increases cost by ten percent. If the value is set to 1, hourglass energy is
not computed. If the value is set to 2, hourglass energy is computed and included in
the energy balance. The hourglass energies are reported in the ASCII files GLSTAT
and MATSUM.
SLNTEN is the sliding interface energy dissipation option. This parameter is always
set to 2 if contact is active. If the option is set to 1, energy dissipation is not
computed. If the value is set to 2, energy dissipation is computed and included in the
energy balance.
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Figure 23: Keyword *CONTROL_ENERGY
*CONTROL_HOURGLASS_{OPTION} is used to redefine the default values of
hourglass control type and coefficient. Hourglass control is viscosity or stiffness that
is added to quadrilateral shell elements and hexahedral solid elements that use
reduced integration. Without hourglass control, these elements would have zero
energy deformation modes which could grow large and destroy the solution.
*CONTROL_HOURGLASS can be used to redefine the default values of the
hourglass control type and coefficient. IHQ is the default hourglass control type. The
list of the available options is presented in Table 8.

Table 8: IHQ Options
EQ
1
2
3
4
5
6

Explanation
Standard LS-DYNA.
Flanagan-Belytschko integration.
Flanagan-Belytschko with exact volume integration.
Stiffness form of type 2 (Flanagan-Belytschko).
Stiffness form of type 3 (Flanagan-Belytschko).
Belytschko-Bindeman assumed strain co-rotational stiffness form for 2D
and 3D solid elements only. Mandatory for implicit analysis.

Figure 24: Keyword *CONTROL_HOURGLASS
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*CONTROL_RIGID presents special control options related to rigid bodies and the
rigid-flexible bodies. For this study, MATELF is important. MATELF is metal
forming option and should not be used for crash and other applications involving
rigid bodies. If this option is active the rotational motion of all rigid bodies should be
suppressed. Option can be activated by setting the value to 1.

Figure 25: Keyword *CONTROL_RIGID

*CONTROL_SHELL provides controls for computing shell response. ISTUPD is
the shell thickness change option for deformable shells. The parameter, PSSTUPD,
on the second optional card allows this option to be applied by part ID. Table 9
summarizes the meanings of values for ISTUPD.
Table 9: ISTUPD Options
EQ
0

2
3

Explanation
No change.
Membrane straining causes thickness change (important for sheet metal
forming or whenever membrane stretching is important).
Membrane straining causes thickness change in 8 node thick shell
elements. types 1 and 2. This option is not recommended for implicit or
explicit solutions which use the fully integrated type 2 element. The type
3 thick shell is a continuum based shell and thickness changes are always
considered.
Options 1 and 2 apply.

4

Option 1 applies. but the elastic strains are neglected for the thickness
update. This option only applies to the most common elastic-plastic
materials for which the elastic response is isotropic.

1
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Figure 26: Keyword *CONTROL_SHELL

*CONTROL_SOLID is used to provide controls for solid element response. ESORT
option is opened for automatically sorting of tetrahedron and pentahedron elements
to treat degenerate tetrahedron and pentahedron elements as tetrahedron and
pentahedron solids, respectively. FMATRX signifies the default method used in the
calculation of the deformation gradient matrix. NIPTETS is the number of integration
points used in the quadratic tetrahedron elements. Either 4 or 5 can be specified. This
option applies to the types 4, 16, and 17 tetrahedron elements.
The purpose of *CONTROL_TERMINATION is to stop the process. ENDTIM
option signifies the termination time. DTMIN is reduction (or scale) factor for initial
time step size to determine minimum time step, TSMIN. TSMIN=DTSTART*DTMIN
where DTSTART is the initial step size determined by LS-DYNA®. When TSMIN is
reached, LS-DYNA® terminates with a restart dump.

Figure 27: Keyword *CONTROL_TERMINATION

Time step of the constructed model is tuned using *CONTROL_TIMESTEP. This
keyword allows the user to choose a variety of options. Initial size of the time step is
set by DTINIT. In case DTINIT is specified as 0.0, initial step size is detected by LSDYNA® automatically. A large timestep can be achieved by adding nonphysical
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mass to the system. This technique is known as mass scaling. However, adding mass
to a dynamic system affects the results according to the second law of Newton (F =
ma). This effect is justifiable if the overall kinetic energy of the system is less than
peak internal energy. For mass scaling, DT2MS is used as the time step size. Inertial
effects can be neglected for quasi-static analyses. In this case, positive values of
DT2MS are preferred. Default value of DT2MS is 0.0. If DT2MS is selected as a
negative number, minimum time step is calculated as TSSFAC x |DT2MS|. Courant
time step size control is performed and if this criterion is not met, mass is scaled.
Mass scaling can be used in transient analyses because additional masses do not
affect the result significantly. Mass scaling can be performed for all the elements of
the system, or for only the selected elements of the system. To improve the quality of
the simulation, instead of global mass scaling, local mass scaling should be preferred
and it can be achieved using negative values of DT2MS.

Figure 28: Keyword *CONTROL_TIMESTEP

Figure 29: *DATABASE_BINARY_D3PLOT
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Simulation of nonlinear models require correct manipulation of damping for all
members of the physical system. According to the Rayleigh damping equation;
damping matrix C is calculated as
C = μM + λK,

(20)

where, the first term is called as mass term, and the second term is called as stiffness
term. To eliminate probable effects of impact, crash and vibration, LS-DYNA®
allows the users to define nodal damping. The purpose of *DAMPING_GLOBAL
is to define nodal mass damping that is implemented on the nodes of deformable
sheet metal and on the center of mass of the rigid bodies. Damping constant of the
system can be set to a specific value with VALDMP, or damping can be defined as a
function of time in LCID (load curve ID). Since *DAMPING_GLOBAL is applied
to all members of the system, it is advised to use *DAMPING_GLOBAL only in
cases where rigid body motions are insignificant. For the cases including significant
rigid body motion, *DAMPING_PART_MASS should be preferred where
individual parts can be selected to include damping.
The database definitions are optional, but are necessary to obtain output files
containing results information. *DATABASE_BINARY_OPTION is the options
for binary output files. D3PLOT outputs Dt for complete output states. DT is the
time interval between outputs.
The keyword *DEFINE provides a way of defining boxes, coordinate systems, load
curves,

tables,

and

orientation

vectors

for

various

uses.

*DEFINE_CURVE_{OPTION} is used to define a curve [for example, load
(ordinate value) versus time (abscissa value)], often referred to as a load curve. LCID
is the load curve ID. SFA is the scale factor for abscissa value. This is useful for
simple modifications. Likewise, SFO is the scale factor for ordinate value (function).
Default values of both options are 1.0.
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Figure 30: *DEFINE_CURVE

*HOURGLASS defines hourglass and bulk viscosity properties which are
referenced via HGID in the *PART command. QM is the hourglass coefficient.
Values of QM that exceed 0.15 may cause instabilities for all shell hourglass control
and brick forms 0 to 5. The stiffness forms can stiffen the response especially if
deformations are large and therefore should be used with care. For the shell and
membrane elements QM is taken as the membrane hourglass coefficient, the bending
as QB, and warping as QW. These coefficients can be specified independently, but
generally, QM=QB=QW, is adequate. Q1 is the quadratic bulk viscosity coefficient.
Q2 is the linear bulk viscosity coefficient.

Figure 31: *HOURGLASS
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The

keyword

*LOAD

provides

a

way

of

defining

applied

forces.

*LOAD_RIGID_BODY is employed for the purpose of applying a concentrated
nodal force to a rigid body. The force is applied at the center of mass or a moment is
applied around a global axis. As an option, local axes can be defined for force or
moment directions. DOF stands for the applicable degrees-of-freedom (Table 10).

Table 10: Applicable Degrees of Freedom
EQ
1
2
3
4
5
6
7
8

Explanation
x-direction of load action.
y-direction of load action.
z-direction of load action.
Follower force.
Moment about the x-axis.
Moment about the y-axis.
Moment about the z-axis.
Follower moment.

LCID is the load curve ID or function ID. This option only applies to load curves.
The global coordinate system is the default. The local coordinate system ID’s are
defined in the *DEFINE_COORDINATE_SYSTEM section. This local axis is
fixed in inertial space, i.e., it does not move with the rigid body. Nodes M1, M2, M3
must be defined for a follower force or moment. The follower force acts normal to
the plane defined by these nodes as depicted in Figure 32. The positive t-direction is
found by the cross product t = v × w where v and w are vectors as shown. The
follower force is applied at the center of mass. A positive follower moment puts a
counterclockwise torque about the t-axis.
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Figure 32: Follower Force and Moment Acting On A Plane Defined By Nodes m1,
m2, and m3

Figure 33: *LOAD_RIGID_BODY

*MAT_RIGID is designed by LS-DYNA® to meet the criteria of rigid body
definitions. Using that keyword, solid bodies and 2-dimensional shells can be
transformed into rigid elements. This transformation is a needed property, since the
solution of deformable body equations is tedious compared to rigid body analysis.
The case studies covered in Chapter 4 of the thesis represent are a good example of
this transformation, because, the tools were properly and accurately treated as rigid.
Elements which are rigid are ignored in the processing and no storage is assigned to
retain history variables. Therefore, the rigid material type is very cost efficient. Two
separate rigid parts may not possess common nodes unless they are merged together
using the rigid body merge option. Three material properties; RO (mass density), E
(Young’s

modulus), and PR (Poisson’s ratio) are needed to define a rigid material in

LS-DYNA®. These properties are only needed to detect sliding interface parameters
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for contact algorithms. Values of material properties must be defined as realistically
as possible to eliminate probable numerical problems in contact. CMO is center of
mass constraint option. Table 11 lists available options for CMO.
Table 11: CMO Options
EQ
1
0
-1

Explanation
Constraints applied in global directions,
No constraints
Constraints applied in local directions (SPC constraint).

CON1 is the first constraint parameter. If CMO=+1.0, then one should specify global
translational constraint from the list of available list of constraints in Table 12.

Table 12: CON1 Options
EQ
0
1
2
3
4
5
6
7

Explanation
No constraints,
Constrained x displacement,
Constrained y displacement,
Constrained z displacement,
Constrained x and y displacements,
Constrained y and z displacements,
Constrained z and x displacements,
Constrained x, y, and z displacements.

CON2 is the second constraint parameter. If CMO=+1.0, then one should specify
global rotational constraint from the list of available list of constraints in Table 13.
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Table 13: CON2 Options
EQ
0
1

Explanation
No constraints,
Constrained x rotation,

2
3
4
5
6

Constrained y rotation,
Constrained z rotation,
Constrained x and y rotations,
Constrained y and z rotations,
Constrained z and x rotations,

7

Constrained x, y, and z rotations.

Figure 34: *MAT_RIGID

*MAT_BARLAT_YLD2000 was developed by Barlat et al. to overcome some
shortcomings of the six parameter Barlat model implemented as material 33 (MAT_
BARLAT_YLD96) in LS-DYNA. This model is available for shell elements only.
RO is mass density, E is Young’s modulus. PR is Poisson’s ratio. HARD determines
the hardening law of the material.
EQ.1.0: Exponential hardening:

y

EQ.2.0: Voce hardening:

0

p

)n

a be

c

p

k(

y

(21)
(22)

EQ.3.0: Hansel hardening:
EQ.4.0: Gosh hardening:

y
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EQ.5.0: Hocket-Sherby hardening:
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(24)

According to prefferred hardening rule, required material parameters need to be
entered in the keyword.

Figure 35: *MAT_BARLAT_YLD2000
HARD allows the user to import a predetermined flow curve to detect unformulated
hardening rule. For this option, user should create a flow curve from *DEFINE_
CURVE card and input the ID number of this curve with a minus (-) sign.

The yield condition for this material can be written where
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The X'i and X''i are eigenvalues of X'ij and X''ij and are given by
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and

respectively. The X'ij and X''ij are given by
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6
8

The parameters α1 to α8 are the parameters that determines the shape of the yield
surface. The material parameters can be determined from three uniaxial tests and a
biaxial test. From the uniaxial tests the yield stress and R-values are used and from
the biaxial test an arbitrary point on the yield surface is used given by the stress
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components in the material system as together with a tangent of the yield surface in
that particular point. For the latter the tangential direction should be determined so
that

dxx xxp d yy yyp 2dxy xyp

0

(35)

xx
yy

(36)

xy

The biaxial data can be set to zero in the input deck for LS-DYNA® to just fit the
uniaxial data.
The list of parameters in the material card are explained in Table 14.

Table 14: Parameter List For *MAT_BARLAT_YLD2000
SIG00
SIG45
SIG90
R00
R45
R90
SIGXX
SIGYY
SIGXY
DXX
DYY
DXY

Yield stress in 00 direction
Yield stress in 45 direction
Yield stress in 90 direction
R-value in 00 direction
R-value in 45 direction
R-value in 90 direction
xx-component of stress on yield surface
yy-component of stress on yield surface
xy-component of stress on yield surface
xx-component of tangent to yield surface
yy-component of tangent to yield surface
xy-component of tangent to yield surface

*PART is used to define parts, i.e., combine material information, section properties,
hourglass type, thermal properties, and a flag for part adaptivity. SECID is the
section identification defined in the *SECTION section. MID is the material
identification defined in the *MAT section. HGID is Hourglass/bulk viscosity
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identification defined in the *HOURGLASS Section. ADPOPT indicates if this part
is adapted or not.
In *SECTION, the element formulation, integration rule, nodal thicknesses, and
cross sectional properties are defined. All section identifiers defined in this section
must be unique, i.e., if a number is used as a section ID for a beam element then this
number cannot be used again as a section ID for a solid element.
*SECTION_SHELL defines section properties for shell elements. ELFORM is used
to set element formulation options (Table 15). Deafult Belytschko-Tsay option is
preferred. SHRF is the shear correction factor which scales the transverse shear
stress. NIP is the number of through thickness integration points. The integration
points are stacked vertically at the centroid of the element. Number of integration
point can be set to any number between 1 and 10. However, if the number is set to 1,
bending effect is neglected. Default value is 2. For linear elastic materials, strains are
linear through the thickness. Therefore, for rigid materials, general tendency is to
choose 2. On the other hand, 2 integration points cause extrapolation of the stresses
to the surfaces. In this case, the difference in stress between the surface and the
outermost integration point cannot be tolerated. General policy for nonlinear
materials, is to pick at least 4 integration points and ignore the error which is around
14 %. However, in this project, for sheet and rubber materials, number of integration
points were set to 7 to increase the accuracy of the study. T1, T2, T3 are shell
thicknesses at nodes n1, n2, and n3.

Figure 36: *PART
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Figure 37: *SECTION_SHELL
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Table 15: Element Formulation Options
EQ
1
2
3
4
5
6
7
8
9
10
11
12
13

Explanation
Hughes-Liu,
Belytschko-Tsay (default),
BCIZ triangular shell,
C0 triangular shell,
Belytschko-Tsay membrane,
S/R Hughes-Liu,
S/R co-rotational Hughes-Liu,
Belytschko-Leviathan shell,
Fully integrated Belytschko-Tsay membrane,
Belytschko-Wong-Chiang,
Fast (co-rotational) Hughes-Liu,
Plane stress (x-y plane),
Plane strain (x-y plane),

14

Axisymmetric solid (y-axis of symmetry) - area
weighted,

15
16
17

Axisymmetric solid (y-axis of symmetry) volume weighted,
Fully integrated shell element (very fast),
Fully Integrated DKT, triangular shell element,

18
20
21
22

Fully Integrated linear DK
qaudrilateral/triangular shell,
Fully integrated linear assumed strain C0 shell
Fully integrated linear strain C0 shell (5DOF)
Linear shear panel element (3 DOF per node)

23

8-node quadrilateral shell (under development)

24
25
26
27
31
32
33

6-node quadratic triangular shell (under
development)
Belytschko-Tsay shell with thickness stretch.
Fully integrated shell with thickness stretch.
C0 triangular shell with thickness stretch.
1 point eulerian Navier-Stokes,
8 point Eulerian Navier-Stokes,
CVFEM Eulerian Navier-Stokes.EQ.

46

Cohesive element for two-dimensional plane
strain, plane stress, and area-weighted
axisymmetric problems (type 14 shells).

47

Cohesive element for two-dimensional volumeweighted axisymmetric problems (use with type
15 shells).
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3.4 Steps To Construct A Simulation
Depending on the process, the details to model a manufacturing operation differs.
Despite, general steps to construct the simulations are almost same and are presented
in Figure 39.

Figure 38: Steps To Construct A Simulation In LS-Dyna
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-

Decide on symmetry: The process to be modeled may include a axisymmetrical shapes. In this case, half or quarter of the model will give the
same results compared to full model. In order to reduce the analysis time, half
and quarter models should be preferred.

-

Preparation of 3D model: 3D model of dies, punch, and sheet metal are
required. One can prepare the models in *iges or *step format.

-

Screening the redundant parts: Simulation file does not have to include all
the details about dies, i.e, the holes, bolts, screws, nuts, etc. Therefore, it is
advised to erase those details from the model.

-

Importing simplified model to LS-Dyna: Simplified model is imported to
LS-Dyna.

-

Removing noncontacting surfaces from the model: This step is for resimplification of prepared model. Removal of noncontacting surfaces from
the model is profitable in terms of processing time.

-

Mesh generation: Meshing of final geometry of the model is performed.
Abundance of the nodes is desired in terms of quality of the result. On the
other hand, complexity of the model is a drawback for calculation and is not
demanded. Therefore, deciding on mesh sizes is a compulsive task. In
general, successful meshing can be performed by
Using smaller meshes on curved surfaces
Using smaller meshes on tool surfaces compared to sheet metal
Using tetrahedron meshes on solid geometries
Preferring homogeneous and symmetrical node distribution on
surfaces

Meshing can be succeeded using Element and Mesh -> Automesher command with
the settings shown in Figure 39.
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Figure 39: Auto Mesher Settings
The geometry to be meshed is selected using cursor. Clicking Mesh, user can
visualize the mesh geometry and can decide whether the mesh size is suitable.

-

Defining symmetry and boundary conditions: Symmetry and boundary
conditions of the elements should be defined for corrrect calculations.

-

Checking surface normals: Each shell surface has normal vectors. The
normal vectors shall be directed in a way compatible with the motion of the
part.

-

Defining rolling direction for sheet metal: Rolling direction matters for
sheet metal processing. LS-Dyna shows the rolling directions for metal and
directions can be modified.

-

Motion definition: For the dynamic elements of the model, velocity,
acceleration, or displacement curves should be defined.
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-

Contact definition between surfaces: In order for the different surfaces to
sense each other, contacts should be defined. Each contacting surface can be
defined using keyword *CONTACT.

-

Defining control cards: Simulation time, accuracy of the model, penetration
checks, and remeshing options need to be decided and defined. Keyword
*CONTROL is employed for this purpose.

-

Defining output and database files: Depending on the complexity of the
simulation, user should decide on the desired output files and time interval
between successive results. Keyword *DATABASE is employed for this
purpose.

-

Defining hourglass option: Consider a single reduced-integration element
modeling a small piece of material subjected to pure bending (Fig 40).

Figure 40: Deformation of A Linear Element With Reduced Integration Subjected To
Bending Moment M

The length of the dotted lines and the angle between the lines remain unchanged
during bending process. This is the indication of a case where neither strain nor
stress occurs. Therefore, this element possess zero-energy. Zero-energy modes
can no longer resist deformation due to lack of stiffness. If the preferred meshes
sizes are large, absurd results can emerge due to propagation of zero-energy
modes [29]. Hourglass problem can be diagnosed comparing the internal energy
and hourglass energy of the system. To solve hourglass problem,
-

Fully integrated elements can be used, however it is an expensive approach in
terms of processing

-

Special algorithms of LS-DYNA (*HOURGLASS keyword) are employed to
form artifical stiffness by adding counteracting forces.
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-

Defining material properties: The elements of the model should be defined
in terms of material properties. Keyword *MAT is employed for this purpose.

-

Defining section properties: The material can be shell or solid. Depending on
the type of the element, suitable *SECTION card is used.

-

Assigning material and section properties to geometry: With keyword
*PART, properties for each element shall be assigned.

-

Model check: LS-Dyna allows a full model check before running the
analysis. This way, probable contradictions for keyword definitions are
detected and can be eliminated.

Figure 41: LS-Dyna Model Check

-

Analysis: Prepared model can be analysed clicking the “Start LS-Dyna
Analysis Button” on the LS-Dyna Program Manager.
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Figure 42: LS-Dyna Analysis

Subsequently, “Start Input and Output” screen appears.

Figure 43: Start Input and Output Screen

Depending on the hardware of the computer and the number of licences available,
NCPU and memory can be manually adjusted.
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-

Analysis check: Analysis check should be performed in order to detect any
erroneous input and keyword definition. This control can be performed
during analysis. Therefore, the user does not have to wait for the completion
of the analysis. Analysis can be visualized by clicking “LS-Dyna Binary
Plot”button on LS-Prepost screen and choosing *d3plot file.

Figure 44: LS-Dyna Binary Plot
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CHAPTER 4
CASE STUDIES
4.1 Introduction
In the previous chapters, the finite element modeling procedure for a simple forming
process is summarized. On the other hand, more complex shaped products are
required to be investigated in order to prove the success of proposed method. For this
purpose, real gas turbine parts were simulated numerically, and then the geometry of
the parts were inspected. In the first case study, deep drawing process is analyzed
using LS-DYNA®. In the second study, rubber pad forming process modeling steps
are explained. Finally, segmented radial expansion process modeling is shown in
detail. This chapter is devoted to real applications.
4.2 Case Study 1: Deep Drawing Process
To simulate deep drawing process of a gas turbine part, one needs to have the 3D
model of all the die elements. The model can be constructed in any 3D software such
as Unigraphics NX®, SolidWorks®, or CATIA®. However, the file type that LSDYNA® can import is limited to .iges and .step. Therefore, the constructed 3D model
must be a step or iges file.

3D model has elements such as die, punch, blank holder. Additionally, it has bolts,
holes, curves, fitting elements. Since the 3D model is symmetric, simulation is
constructed with ¼ of dies. Therefore, partial model needs to be constructed. Easiest
way to develop a partial model is to divide the elements on 3D model software.
Geometry of dies can be imported using the button File->Open->IGES File or File>Open->STEP File depending on the file type.
The imported model includes redundant elements: bolts, curves, holes. They need to
be erased either using delete command or from the part list tree.
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For this case, sheet metal (blank) is also imported. Sheet metal geometry is also
symmetrical and therefore ¼ of metal is needed. Import can be succeeded with File->
Import-> IGES File or File-> Import-> STEP File commands.
Modeling requires only the surfaces that the sheet metal contacts. Thus, 3D
geometries of die, blank holder, and punch are simplified erasing the noncontacting
surfaces. As a result, model includes only shells.
The meshes for all geometries are defined as depicted in Figure 45.

Figure 45: Deep Drawing Process Simulation Elements

Prepared model is ¼ of the actual size. Therefore, symmetry boundary conditions are
defined. One should note that symmetry boundary condition is defined only for sheet
metal to be formed. The other elements are not supposed to have symmetry
conditions.
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Figure 46: Symmetry Boundary Conditions

Symmetry conditions can be defined from Model and Part -> Create Entity-> Cre
command. For this case, 2 symmetry conditions are defined:
-

Symmetry with respect to yz-plane

-

Symmetry with respect to xz-plane

For the center node, motion can be only in z direction. Therefore, z degree of
freedom is defined with no rotation allowance with respect to z axis.
Surface normals are checked with Element Tools -> Normals command.
Normals for sheet metal, punch, and blank holder are in the direction of motion.
Normals for die are contrary to direction of motion.
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Figure 47: Surface Normals For Sheet Metal

Figure 48: Surface Normals For Punch

Rolling direction for sheet metal matters. Assuming that the sheet metal is rolled in
y-direction, blank in the model is aligned similarly. Alignment is determined from
the command Element Tools -> Element Editing->Direction.
60

Figure 49: Rolling Direction For Sheet Metal

Kinematics of the model is mainly constructed on of the motion of the punch and
blank holder. Motion starts with blank holder closing, and continues with punch
displacement.

Figure 50: Blank Holder Displacament Plot
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Figure 51: Punch Displacement Plot

The motion curves are defined separately in *DEFINE_CURVE keyword. The
motion of the holder is defined in Figure 52.

Figure 52: Blank Holder Closing Curve

Likewise, motion of the punch is defined as shown in Figure 53.
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Figure 53: Punch Displacement Curve

Since the displacement is a form of boundary condition, definition and order of
displacements are entered in keyword *BOUNDARY. Additionally, motion is
enabled by rigid bodies. Therefore *PRESCRIBED_MOTION_RIGID is employed.
New ID is chosen and Punch_drawing_ is written on Title section. The model is
constructed on xy plane, therefore DOF is chosen as 3 (z-translational degree of
freedom). VAD is chosen as 2, since displacement is defined. LCID is chosen as 3
(motion curve of punch). The punch motion is between at 0.01th and 0.2th seconds,
therefore BIRTH value is set to 0.01 and DEATH value is set to 0.2.
Blank holder motion is defined choosing New ID. Punch_closing_ is written on Title
section. DOF is set to 3 and VAD is set to 2. LCID is set as 2. The motion starts at 0
and terminates at 0.01th second. BIRTH is set to 0 and DEATH is set to 0.01.

Figure 54: *PRESCRIBED_MOTION_RIGID
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Contacting

surfaces

are

defined

in

*CONTACT_FORMING_ONE_WAY_

SURFACE_TO_ SURFACE keyword. The contact needs to be defined between
sheet metal and the other components. Therefore three separate entities are
constructed.

Figure 55: Keyword *CONTACT_FORMING_ONE_WAY_ SURFACE_TO_
SURFACE
Static coefficient of friction (FS) is set to 0.18 and penetration check is performed
(PENCHK is set to 1). MSID is changed according to the master ID.
Simulation is explicit, therefore *CONTROL_ACCURACY keyword is employed
setting INN (invariant node number) to 1.

Figure 56: Keyword *CONTROL_ACCURACY

*CONTROL_ADAPSTEP option is enabled with default FACTIN and DFACTR
values.
*CONTROL_ADAPTIVE keyword is enabled with the values shown in Table 16.
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Figure 57: *CONTROL_ADAPTIVE

Table 16: Preferred Parameters For *CONTROL_ADAPTIVE
ADPFREQ
ADPTOL

0.01
3

ADPOPT

2

MAXLVL
ADPSIZE
ADPENE

4
1
1

*CONTROL_CONTACT keyword is enabled with the following values:

Figure 58: *CONTROL_CONTACT

ISLCHK

:

2

SHLTHK

:

1

PENOPT

:

4
65

Hourglassing option is preferred, therefore *CONTROL_HOURGLASS is enabled
with stiffness form of type 2 (Flanagan-Belytschko).
Since fast update is preferred for metalforming applications, *CONTROL_RIGID is
enabled with setting METALF to 1
*CONTROL_SHELL keyword is used with full automatic sorting of triangular shell
elements. ESORT is set to 1. ISTUPD is set to 1 and THEORY is set to 2.

Figure 59: Keyword *CONTROL_SHELL

*CONTROL_TERMINATION is enabled and termination time is set to 0.2.
Reduction factor for initial time step size to determine minimum time step is set to
0.01.
*CONTROL_TIMESTEP is enabled with 0.01 initial step size. DT2MS (Time step
size for mass scaled solutions) is set to -1.200e-006.
*DATABASE_ASCII_option keyword is required for Global Statistics (GLSTAT),
Material Energies (MATSUM), Nodal Interface Forces (NCFORC), Nodal Force
Groups (NODFOR), Resultant Interface Forces (RCFORC). Time interval is set to
0.01 for aforementioned options.
*DATABASE_BINARY_D3PLOT keyword is enabled with 0.01 time interval.
*DATABASE_EXTENT_BINARY keyword is enabled with setting MAXINT to 3,
STRFLG to 1, SIGFLG to 1 and EPSFLG to 1.

66

Figure 60: *DATABASE_EXTENT_BINARY

*HOURGLASS option is enabled setting Hourglass coeffient to 0.1, quadratic bulk
viscosity coefficient to 1.5, and linear bulk viscosity coefficient to 0.06.
Deep drawing dies are subjected to high forces such between 100000 N and 300000
N. For this case, estimated force is about 200000 N. *LOAD_RIGID_BODY is
enabled setting load of action as z-direction. Pod load is defined as a curve in
*DEFINE_CURVE section.

Figure 61: Pod Load
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Figure 62: *LOAD_RIGID_BODY

Sheet metal and die elements are defined separately. Die elements, i.e. die, blank
holder, and punch are rigid materials and designated in *MAT_RIGID option. The
die materials are steel, therefore density (RO) is specified as 7.83e-9. Likewise,
Young's modulus (E) is set to 2.07e5 and Poisson's Ratio (PR) is set to 0.3. Punch
and blankholder are free to move in z direction, therefore CON1 must be set to 4 and
CON2 must be set to 7. For the die, both CON1 and CON2 are set to 7, since it is
fixed in all translational and rotational directions.
Sheet metal material is defined in keyword *MAT_BARLAT_YLD2000. The sheet
material is Inconel 718. Therefore values in Table 17 are entered.

Table 17: Inconel 718 Material Parameters
RO
E
PR
SIG00
SIG45
SIG90
R00
R45
R90
SIGXX
SIGYY

7.8e-9
1.93e5
0.3
522.72699
502.52499
532.39697
0.521
1.474
1.137
518.06403
518.06403

Since the flow curve of Inconel 718 is obtained in the study proposed by Ertan [5],
*DEFINE_CURVE is used to construct flow curve data. Curve ID is set to 1.
Transporting curve information to *MAT_BARLAT_YLD2000 can be achieved by
setting HARD to -1 (1 stands for exponential hardening rule, so it is not used).
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Figure 63: Inconel 718 Flow Curve

*SECTION_SHELL is enabled for all items in the model. Thickness values are set to
1, because sheet material has 1 mm thickness. Number of integration points (NIP) is
set to 7 for sheet metal, while for the other items this number is set to 2.
Assigning section and material information to geometrical entities is succeded by
keyword *PART. It is important that ADPOPT of sheet metal is set to 1 for remeshing. Additionally, Hourglass option (HGID) is set to 1 for sheet metal. Remaing
options are selected according to previously defined section and material keywords.

Figure 64: *PART
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4.3 Case Study 2: Rubber Pad Forming Process
To simulate rubber pad forming process of a gas turbine part, screening of die
elements is performed in a similar fashion to deep drawing case study. This time, 3D
model comprises of die, punch, rubber, and blank. 3D model is symmetric again,
therefore simulation is constructed with ¼ of dies.

Figure 65: Rubber Pad Forming Process Die Elements (1/4)

The models for the die, sheet metal and punch are constructed in the form of shells.
However, accuracy of the simulated process requires 3-D elements for rubber
geomtery. Therefore, meshing of rubber was performed using tetrahedral elements.
For the construction of 3-D elements, solid mesher option is employed.
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Figure 66: Conical Undeformed Sheet Metal (¼)

Figure 67: Solid Meshing
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Prepared model includes ¼ of the actual size. Therefore, symmetry boundary
conditions are defined. One should note that symmetry boundary condition is defined
this time for sheet metal to be formed and for rubber die. The other elements are not
supposed to have symmetry conditions.

Figure 68: Symmetry Boundary Conditions

Symmetry conditions can be defined from Model and Part -> Create Entity-> Cre
command. For this case, 4 symmetry conditions are defined:
-

Symmetry with respect to yz-plane (for sheet metal)

-

Symmetry with respect to xz-plane (for sheet metal)

-

Symmetry with respect to yz-plane (for rubber)

-

Symmetry with respect to xz-plane (for rubber)

Surface normals are checked with Element Tools -> Normals command.
Normals for sheet metal and punch are in the direction of motion. Normals for die
are contrary to direction of motion. The rubber elements are solid elements, therefore
normals are not defined for rubber geometry.
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Figure 69: Surface Normals For Sheet Metal

Figure 70: Surface Normals For Punch
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Rolling direction for sheet metal matters. Assuming that the sheet metal is rolled in
y-direction, blank in the model is aligned similarly.

Figure 71: Rolling Direction For Sheet Metal

Motion is started with punch displacement.

Figure 72: Punch Displacament Plot
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The motion curve is defined in *DEFINE_CURVE keyword as shown in Figure 73.

Figure 73: Punch Displacement Curve

Since the displacement is a form of boundary condition, definition and order of
displacements are entered in keyword *BOUNDARY. Additionally, motion is
enabled by rigid bodies. Therefore *PRESCRIBED_MOTION_RIGID is employed.

Figure 74: Motion

New ID is chosen and Punch_displacement is written on Title section. The model is
constructed on xy plane, therefore DOF is chosen as 3 (z-translational degree of
freedom). VAD is chosen as 2, since displacement is defined. LCID is chosen as 1
(motion curve of punch).
Contacting surfaces are defined in
SURFACE_TO_SURFACE

and

*CONTACT_FORMING_ONE_WAY_

*CONTACT_AUTOMATIC_SURFACE_TO_
75

SURFACE keywords. The automatic surface contact is defined for rubber contacting
surfaces. Forming contact is defined for sheet metal to die contact. Totally four
separate entities are constructed.

Figure 75: Contact Definition (For Rubber Contacting Surfaces Only)

Static coefficient of friction (FS) is set to 0.1 and penetration check is performed
(PENCHK is set to 1). MSID is changed according to the master ID.
*CONTROL keywords are defined exactly in the same way as done for deep
drawing case study. Therefore, it is redundant to repeat procedure steps. For this
case, keywords that are used are
*CONTROL_CONTACT
*CONTROL_HOURGLASS
*CONTROL_SHELL
*CONTROL_SOLID
*CONTROL_TERMINATION (Termination Time: 0.1)
*CONTROL_TIMESTEP

The model includes deformable solid elements, therefore *DAMPING_GLOBAL is
used.

76

Figure 76: *DAMPING_GLOBAL

*DATABASE_ASCII_option keyword is required for Global Statistics (GLSTAT),
Material Energies (MATSUM), Nodal Interface Forces (NCFORC), Nodal Force
Groups (NODFOR), Resultant Interface Forces (RCFORC). Time interval is set to
0.001 for aforementioned options.
*DATABASE_BINARY_D3PLOT keyword is enabled with 0.001 time interval.
*DATABASE_EXTENT_BINARY keyword is enabled with setting MAXINT to 3,
STRFLG to 1, SIGFLG to 1 and EPSFLG to 1.

*HOURGLASS option is enabled setting Hourglass coeffient to 0.1, quadratic bulk
viscosity coefficient to 1.5, and linear bulk viscosity coefficient to 0.06.
Sheet metal, die elements, and rubber are defined separately. Die elements, i.e. die
and punch are rigid materials and designated in *MAT_RIGID option. The die
materials are steel, therefore density (RO) is specified as 7.83e-9. Likewise, Young's
modulus (E) is set to 2.1e5 and Poisson's Ratio (PR) is set to 0.3. Punch and
blankholder are free to move in z direction, therefore CON1 must be set to 4 and
CON2 must be set to 7. For the die, both CON1 and CON2 are set to 7, since it is
fixed in all translational and rotational directions.
Sheet metal material is defined in keyword *MAT_BARLAT_YLD2000. The sheet
material is Inconel 718. Therefore values in Table-16 are entered.
For this case study, material properties are constructed on Voce Hardening rule.
σy = a - be-cεp

77

(37)

Therefore, suitable coefficients obtained from experiments are entered in keyword.
Namely,
K (a in voce hardening law) is set to 1480.5
E0 (b in voce hardening law) is set to 1020.35
N (c in voce hardening law) is set to 4.3888798

Figure 77: Parameters For Voce Hardening Rule

*SECTION_SHELL is enabled for punch, sheet metal, and die (Shell items in the
model). Thickness values are set to 1, because sheet material has 1 mm thickness.
Number of integration points (NIP) is set to 5 for sheet metal, while for the other
items this number is set to 2. ELFORM is set to default value 2 for tools and set to 16
for sheet metal (Fully integrated shell element [very fast]).
*SECTION_SOLID is enabled for rubber. (Solid item in the model). ELFORM is set
to default value 13 because of tetrahedron elements (13 stands for 1 point nodal
pressure tetrahedron for bulk forming).

Figure 78: *SECTION_SOLID
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Assigning section and material information to geometrical entities is succeded by
keyword *PART. Options are selected according to previously defined section and
material keywords.

Figure 79: *PART

4.4 Case Study 3: Radial Expansion Process
Radial expansion process simulation steps are quite paralel to previous cases. 3D
model is symmetric, therefore simulation is constructed with ¼ of die. On the other
hand, for sheet metal, 60° (i.e, 1/6 of metal) is modeled. Because of the segmented
nature of the male dies, only the related segments contacting the sheet metal are
simulated. For this case, 3D model comprises of a female die, 5 segments that act as
male die, and blank.
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Figure 80: Radial Expansion Process Die Elements (1/4) (Only 3 Segments Are
Illustrated, Remaining 2 Segments Are Hidden)
The models for the die, sheet metal and segments are constructed in the form of
shells.
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Figure 81: Undeformed Sheet Metal (1/6)

Figure 82: One of Five Segments
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Prepared model includes 1/6 of the actual size of the blank. Therefore, symmetry
boundary conditions are defined. One should note that symmetry boundary condition
is defined for sheet metal to be formed only. The other elements are not supposed to
have symmetry conditions.
Symmetry conditions can be defined from Model and Part -> Create Entity-> Cre
command. For this case, 2 symmetry conditions are defined:
-

Symmetry with respect to Plane-1

-

Symmetry with respect to Plane-2

For this case study, sheet metal needs to be symmetric with respect to specifically
defined planes. Thus, before defining symmetry boundary conditions, symmetry
planes need to be defined. Symmetry planes can be defined from Keyword -> Define
-> Coordinate System.
While defining a local coordinate system, 3 points are needed. If the primary
direction is along the x-axis, then the z-axis is computed from the cross product of x
and y’, (see Figure), z = x x y’, then the y-axis is computed via y = z x x.

Figure 83: Definition of Local Coordinate System Using Three Nodes When The
Node N2 Lies Along The x-axis

N1 is defined by (X0, Y0, Z0), N2 is defined by (XL, YL, ZL), and N3 by (XP, YP, ZP).
One should note that the coordinates of the points must be separated by a reasonable
distance and not colinear to avoid numerical inaccuracies. Furthermore, care must be
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taken to avoid chains of coordinate transformations because there is no guarantee
that they will be executed in the correct order.
Top view of the model is shown in Figure 84. On the figure, one can see the global
coordinate system at left bottom. Sheet metal is highlighted with white color. First
local coordinate system is shown at the bottom edge of the sheet metal.

Figure 84: Top View

With this information, the 1st coordinate system is created as shown in Figure 83.
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Figure 85: 1st Local Coordinate System

Figure 86: 2nd Local Coordinate System

The symmetry boundary conditions are defined as shown in Figure 87.
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Figure 87: Symmetry Boundary Conditions

Surface normals are checked with Element Tools -> Normals command.
Normals for sheet metal and segments are in the direction of motion. Normals for die
are contrary to direction of motion.
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Figure 88: Surface Normals For Sheet Metal

86

Figure 89: Surface Normals For Segments

Assuming that the sheet metal is rolled in y-direction, blank in the model is aligned
similarly.
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Figure 90: Rolling Direction For Sheet Metal

Motion is started with segment displacement. However, there exists 5 different
segments and each segment has separate motion. In terms of similarity of kinematics,
2 different kind of groups exist (First 3 segments move simultaneously, then
remaining 2 segments move simultaneously). Therefore, for this case, 2 motion
curves are defined. The reason of this discrepancy is that operation is performed
intermittently in the shop. For each motion interval, the blank is rotated 15°, so
contacting surfaces of segments with the blank vary. For each rotation step, group of
moving segments shifts.
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Figure 91: Segment Group 1 Displacament Plot

Figure 92: Segment Group 2 Displacament Plot
*PRESCRIBED_MOTION_RIGID is employed with 9 different entities. According
to global coordinate system, 4 segments move in x-y coordinate system and therefore
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motion in each coordinate system is defined separately (4x2=8). The 5th segment
move in x-direction only, so 1 motion curve is enough. That makes 9 motion
definitions in total.

Figure 93: Motion

Figure 94: 5th Segment Moves In x-Direction Only
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The model is constructed on xy plane, therefore DOF is chosen as 3 (z-translational
degree of freedom). VAD is chosen as 2, since displacement is defined. LCID and SF
are chosen according to the segment number.
Contacting

surfaces

are

defined

in

*CONTACT_FORMING_ONE_

WAY_SURFACE_TO_ SURFACE keyword. Totally six separate entities are
constructed.

Figure 95: Contact Definition

Static coefficient of friction (FS) is set to 0.15 and penetration check is performed
(PENCHK is set to 1). MSID is changed according to the master ID.
*CONTROL keywords are defined exactly in the same way as done for previous
case studies. Therefore, it is redundant to repeat procedure steps. For this case,
keywords that are used are
*CONTROL_ADAPTIVE
*CONTROL_CONTACT
*CONTROL_HOURGLASS
*CONTROL_SHELL
*CONTROL_TERMINATION (Termination Time: 0.08)
*CONTROL_TIMESTEP
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*DATABASE_ASCII_option keyword is required for Global Statistics (GLSTAT),
Material Energies (MATSUM), Nodal Interface Forces (NCFORC), Nodal Force
Groups (NODFOR), Resultant Interface Forces (RCFORC). Time interval is set to
0.001 for aforementioned options.
*DATABASE_BINARY_D3PLOT keyword is enabled with 0.001 time interval.
*DATABASE_EXTENT_BINARY keyword is enabled with setting MAXINT to 3,
STRFLG to 1, SIGFLG to 1 and EPSFLG to 1.

*HOURGLASS option is enabled setting Hourglass coeffient to 0.1, quadratic bulk
viscosity coefficient to 1.5, and linear bulk viscosity coefficient to 0.06.
Sheet metal, die, and segments are defined separately. Die is rigid material and
designated in *MAT_RIGID option. The die materials are steel, therefore density
(RO) is specified as 7.83e-9. Likewise, Young's modulus (E) is set to 2.1e5 and
Poisson's Ratio (PR) is set to 0.3. Segments are free to move in x and y directions,
therefore CON1 must be set to 3 and CON2 must be set to 7. For the die, both CON1
and CON2 are set to 7, since it is fixed in all translational and rotational directions.
Sheet metal material is defined in keyword *MAT_BARLAT_YLD2000. The sheet
material is Waspaloy.
For this case study, material properties are constructed on Voce Hardening rule.
σy = a - be-cεp

(38)

Therefore, suitable coefficients obtained from experiments are entered in keyword.
Namely,
K (a in voce hardening law) is set to 1696.6
E0 (b in voce hardening law) is set to 1297.21
N (c in voce hardening law) is set to 3.0365

92

Figure 96: Parameters For Voce Hardening Rule

*SECTION_SHELL is enabled for segments, sheet metal, and die. Thickness values
are set to 1.1, because sheet material has 1.1 mm thickness. Number of integration
points (NIP) is set to 11 for sheet metal, while for the other items this number is set
to 5. ELFORM is set to default value 2 for tools and set to 16 for sheet metal (Fully
integrated shell element [very fast]).

Figure 97: *SECTION_SHELL

Assigning section and material information to geometrical entities is succeded by
keyword *PART. Options are selected according to previously defined section and
material keywords.

Figure 98: *PART
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CHAPTER 5
EVALUATION OF RESULTS WITH LS-PREPOST
According to the flow chart depicted in Section 3.4, after a successful run is
performed, “analysis check” step is needed. In order to evaluate the results of a
model, LSDyna Binary plot file of that specific model is opened in LS-Prepost
screen. Here, model is visualized in a similar fashion to keyword file. On the other
hand, a window with “Animate” title appears (Figure 99). Animate window is useful
in terms of visualizing transient response of the elements in the analysis. Depending
on the number of steps in the analysis, each step can be investigated.

Figure 99: LS-DYNA Binary Plot Screen
Generally, the tendency is to investigate sheet metal (blank) behaviour only.
Therefore, the other items of the model are blanked from select part menu.
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Figure 100: LS-DYNA Binary Plot Screen (Only Blank Is Visible)

The sheet metal behaviour can be checked by forming limit diagram. However, in
order to visualize the effects such as cracks and wrinklings on sheet metal,
*DATABASE_EXTENT_BINARY keyword must be enabled before the analysis.
Instantaneous strain changes can be exported to “d3plot” file by setting the STRFLG
option to 1 (Figure 60). This option is made visible by first clicking “Post” button
and then “FLD” button from the pre-post screen. Previously prepared FLD file is
added to the program by first selecting “File” and then “Browse” button (Figure 101102).
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Figure 101: FLD File Import
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Figure 102: FLD File Import
After importing the FLD file, the curves should be checked using plot command
(Figure 103).

Figure 103: FLD Plot
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In FLD screen, “Point” or “Strain Path” needs to be chosen in order to detect the
response of a specific point by monitoring its position on FLD curve. For this
purpose, “Formability” option is selected and a point on the part is clicked. FLD
curve can be modified by altering the saftey margin, allowable thinning and
allowable thickening (Figure 104).

Figure 104: FLD Modification
Activating formability option, one can see different colors for the all possible sheet
metal responses against applied forces (Figure 106). Formability index is shown in
Figure 105.
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Figure 105: Formability Index

Figure 106: Formability Diagram
One can visualize the location of each point in FLD curve. First, “FLD Fan” is
chosen. Then, final state of the analysis is chosen. Finally, “Plot” is clicked. Figure
107 shows the point and strain path options.
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Figure 107: Point Locations In FLD Curve

Apart from formabiliy diagram, LS-DYNA® allows the user to inspect the stress,
strain, displacement, and thinning values. This option can be activated by clicking
the button “Fringe Component” and then selecting the desired property of the
element. For instance, von-Mises stress distribution throughout the sheet metal is
shown in Figure 108.

Figure 108: von-Mises Stress
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Anticipated results can be written on text files by clicking “Output” button and then
selecting the preferred data. Then, the state number is entered and “write” button is
clicked.

Figure 109: Output Screen

In order to export the geometry of formed sheet metal, the animate window is opened
and last state is monitored. Then, from Model -> Select Part only sheet metal is
made visible. Finally, geometry of the shaped sheet metal is saved from File -> Save
As -> Save Geom As...(Figure 110).
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Figure 110: Geometry Export
Although the procedure outlined in previos sections is straightforward, sheet metal
forming processes can only be perfomed in reality if the machine has the needed
capacity. LS-Dyna® has the capability to calculate the required force, therefore the
required capacity of the press machine to perform a specified task can be easily
predicted in LS-Dyna. For that purpose, one should include “RCFORCE” and
“BNDOUT” options in *DATABASE_OPTION keyword (Figure 111).

Figure 111: BNDOUT Option
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After the completion of the analysis, “Post” option is opened. Here, “ASCII” is
clicked. Then, “rcforc” is selected and loaded (Figure 112).

Figure 112: Loading The Applied Forces
Among the available elements, relative forces and moments can be plotted after
choosing the contacting entities and then desired force/moment. Finally, “Plot”
command needs to be clicked to visualise the instantaneous force/moment (Figure
113). One should note that, the force/moment is calculated depending on the
constructed model. If the model represents ¼ of the real process, then simple
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arithmetic may be required in order to obtain the real forces (such as multiplying by
4) depending on the direction of the force/moment vector.

Figure 113: Force vs Time Graph
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CHAPTER 6
SPRINGBACK ANALYSIS

6.1 Introduction
Sheet metals exhibit elastic and platic deformation when they are subjected to stress
at room temperature. When the loads are removed, elastic portion of the deformation
is recovered. Elastic strains are not distributed uniformly on the workpiece, therefore,
a complete recovery is not possible. Instead, the system reaches the equilibrium.
Springback is defined as the recovered deformation at this stage. Some of the elastic
stresses are confined in the workpiece and generate residual stresses. Targeted
geometry of a sheet metal part can only be obtained if the residual stresses are
defeated. Generally, this can be achieved by additional bending of the workpiece.
The amount of additional bending is dictated by the severity of the springback [30].

Figure 114 shows how stress-strain properties are affected by the three different
bending methods: air forming, bottom bending, and coining. The elastic zone is
where the material is moved but not bent. When the stress is released, the material
returns to its original shape without any permanent deformation. When enough
penetration is applied, the material reaches its yield point, and the metal begins to
deform permanently [31].
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Figure 114: Effects of Coining, Bottom Bending, and Air Forming On Elastoplastic
Deformation [31]
In the air forming zone, the workpiece starts bending due to loads applied by the
press. When the applied loads are removed, sheet metal springs back to compensate
the residual stress. The degree of springback is a function of die radius and material
of the workpiece. Generally, if the inner radius of the die and sheet metal thickness
have the same value, the springback does not exceed 2 degrees. However, the
increase of inner radius causes significant increases of springback values. Highstrength steels exhibit more springback compared to general grades of steels and
aluminum alloys [31].
In the bottoming zone, the material contacts the bottom of the die, angularly
overbending an amount equal to the springback, and then experiences a brief stage of
negative springback as the pressure is increased. As the force continues to increase,
the bending process enters into the coining zone, where an overbend happens
instantaneously before springforward occurs again. Ultimately, the springback and
springforward forces average out, coining process is initiated. With this process, the
final product has no springback remaining. Because in a coined sheet metal part, the
punch tip penetrates the neutral axis while thinning the material at the point of bend,
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realigning the material’s molecular structure. At this point, the material’s integrity is
sacrificed [31].
6.2 Springback in LS-DYNA®
For sheet metal forming operations like drawing it entails deforming the sheet metal
passed the planned net shape of the part, so that when springback is released from the
part, the plastic deformation in that part delivers the desired shape of the part. In the
case of complex tools the springback has to be already considered in the design
stage. In LS-DYNA®, springback analysis can be performed in two ways:
-

When the die motions are completed, male dies or segments are relocated to
initial non-contacting positions

-

When the die motions are completed, male dies or segments are not relocated.
Instead, a new analysis is performed to visualize only the springback
response.

An example of the first case (relocation case) can be seen in the Figure. The figure
shows the time dependent plot of a punch displacement. Normally, deformation takes
place between 0 – 2 seconds. However, the punch is relocated to initial position after
2nd second to analyse springback effect.

Figure 115: Punch Motion Curve
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Implementing the second case is a time consuming process compared to the first
case. The following steps are applied respectively for the second case:
-

Primarily, the prepared model is opened in LS-Prepost.

-

Springback analysis is performed for blank (sheet metal) only. Therefore a
part set is created for blank as shown in Figure 116.

Figure 116: Set Part

-

*INTERFACE_SPRINGBACK_LSDYNA keyword is opened. In this card,
PSID is set to Set Part number.
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Figure 117: Keyword *INTERFACE_SPRINGBACK Keyword

-

In order to have stress and strain values of the formed blank in an output file,
*DATABASE _ EXTENT_BINARY card is opened. STRFLG and SIGFLG
options are set to 1.

-

The model to analyze springback is saved and run. After the analysis is
completed, the folder of *k is opened. Here, “dynain” file is saved in a new
folder.

-

*k file and “template.k” file are saved into this new folder.

-

“template.k» file is opened with Ls-Prepost. “dynain” file is imported in this
template from File -> Imporrt -> LS-DYNA® Keyword File.

-

To assign materials to new springback model easily, the keywords of the
previous model are separated from Misc -> Keyword File Separate.
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Figure 118: Misc Menu
-

In “Original File” section, Browse is clicked and first *k file is detected.

-

A file name such as “mat” is written in “Extracted Files” section, and then
“Add” button is clicked. Thus, new file to extract material data is detected.

Figure 119: Keyword File Separate
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-

SECTION, PART ve MAT cards are required for the blank. Therefore, the
aforementioned cards are chosen and >> button is clicked. Chosen data is
transmitted to “mat” file in that way. If material is defined with a flow curve,
DEFINE section should be transmitted also.

-

File is created by clicking Execute.

-

Finally, in the combined model of “template” and “dynain” files, mat file is
imported from File -> Import > LS-DYNA® Keyword File.

Figure 120: Import Material File

-

If the unnecesary cards are imported, they need to be erased.

-

Similarly, redundant PART data can be written. Those definitions shall be
erased too. The crucial point here is “auto created” file and it should no be
erased.

-

From Model -> Partd, section and material are assigned to “auto created”
element.
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Figure 121: Assigning Section and Part To “Auto created”

-

Part set is created for blank. To create a Part set, blank is clicked in part set
screen.

Figure 122: Entity Creation and SET PART Screen
-

One should note that, Part Set number should be the same number in PSID in
Interface -> Springback_Lsdyna card.
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-

Prepared *k file is saved with a different name. “BySubSystem” tick should
be removed.

-

Before the analysis, LS-DYNA® Solver needs to be changed. For this,
Solver -> Select LS-DYNA® Solver menu is opened in Manager.

Figure 123: LS-DYNA Solver Selection
-

Program

opens

the

index

of

solvers

automatically.

Here,

ls-

dyna_smp_d_R711_win64_ifort131 file is chosen. (Name of the file may
change according to the LD-DYNA version. The file should include «d»
letter.)
-

Analysis output file is opened. Springback analysis is shown in 2 steps. The
1st step shows before springback, while the 2nd step shows the springback
effect.
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Figure 124: Resultant Displacement Mode For Springback Analysis
6.3 Springback Compensation With DYNAFORM®
Although the aforementioned procedures are quite useful to predict sprinback effect,
those procedures do not propose a solution to modify die geometries for anticipated
final geometry of sheet metal. Instead of time-consuming manual trial and error
methods to optimise tool geometries, DYNAFORM® can be employed to perform
compensation of the die geometries. After a successful simulation run with LSDYNA, die and sheet metal geometries are to be exported in *stl format. This way,
geometries can be imported to DYNAFORM.
DYNAFORM performs the necessary calculations to estimate improved tool
geometry by determining the relationship between the calculated geometry and
targeted geometry of the sheet metal. Figures 125 and 126 shows SCP module screen
and Compensation tool in DYNAFORM.
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Figure 125: SPC Module in DYNA-FORM

Figure 126: Springback Compensation Tool
The buttons and their significances in Springback Compensation Tool are as follows:
-

Blank before Springback (

): Condition before springback. A form is

added belonging to each iteration.
-

Blank after Springback (

): Blank geometry after springback. A form is

added belonging to each iteration.
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-

Desired Blank Shape (

): *dynain file after first shaping iteration.

Requires geometry before springback for the very first iteration. This is used
as the ideal part geometry.
-

Compensated Blank Shape (

): Contains “Desired Blank Shape” at 1st

iteration. (Solution for each iteration creates two new data, namely,
“disp.temp” and “rigid.new”.) For the 2nd and later iterations, “disp.temp”
created at the previous iteration must be provided which contains the
compensation displacements.
-

Master Tools (

-

Slave Tools (

): Die geometry according to chosen iteration method.
): Die geometry constructed based on changes on Master

Tools.
-

Smooth Level: Checks smoothness of the modified surfaces. A high level of
smoothness can be accomplished by choosing high values.

-

Scaling Factor: Determines the level of compensation.

-

Method: Extrapolation methods.

Extrapolation method 7 is preferred in terms of limiting the modification zones in
punch, binder, and die. If the punch and binder are defined as master tools, binder
geometry is not affected, only punch geometry is modified. On the other hand, in
case the die geometry is specified as master tools; both die and binder geometries are
subject to changes. Magnitude of springback is also a factor affecting the smoothness
of the geometries after modification.
After the completion of analysis process, two files (“rigid.new” and “disp.tmp”) are
generated. “rigid.new” includes the geometry of new die surfaces. “disp.tmp” is the
file that will be processed by “compensated shape” in the following iteration. The
scheme of processing steps is illustrated in Figure 127.
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Figure 127: Process Steps For Springback Compensation in DYNAFORM
Following the introduction of the geometry of the die elements, the process can be
started selecting “Submit” button in Springback Compensation tool. Then, “Job
Submitter” option is selected and analysis process begins. During processing, a new
folder is created automatically and new die geometry appears as “rigid.new” in this
new folder.
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Figure 128: Submitting A Job
After the completion of the analysis process, compensated die geometry included in
the “rigid.new” can be imported to the process screen from SCP -> Undercut menu
as depicted in Figure 129. Among the parts the last ones created during the
compensation computation are the compensated new tool geometries.

Figure 129: Undercut Check
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Modified tool geometry can be extracted using export command. File extension
should be selected as *stl. One should note that only the geometry to be exported
should be activated before export process.

Figure 130: Geometry Export
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CHAPTER 7
RESULTS
The developed flow chart for the finite element simulation procedure in this thesis
has been a very useful technique in terms of obtaining accurate results following a
systematic approach. Considering previous scientific research related to finite
element modeling of sheet metals, the presented flow chart has been a novel
improvement and can be used as a reference point for future studies in this field. For
each process simulation cases covered in Chapter 4, the same flow chart was
employed without any modification, therefore, the advantage of the pursued
algorithm is proven. Another novelty presented in the thesis is the introduction of a
process that has not been addressed in previous scientific literature in detail:
expanding. Although expanding is not a popular process, this paper can universalize
the utilization of this process on cylindrical sheet metals.

The success of a process simulation depends highly on the accuracy of the properties
of the materials cards that are employed. Therefore, this study includes the
application of the experimental studies to virtual reality. Preparation of material
cards for superalloys requires conducting metal characterization tests, since flow
curves and forming limit diagrams of superalloys are not presented in scientific texts
– they are confidential and unfamiliar materials to manufacturing companies. In that
respect, when the studies performed by Ertan [5] and studies presented in this thesis
are combined, the acquired data of superalloys can contribute to ongoing material
characterization research. The experimental procedures to obtain material data is
explained by Ertan [5]. Experimentally determined forming limit diagrams of
superalloys are shown in Figure 131. According to the figure, the forming limit curve
of Hastelloy has the highest strain values compared to other superalloys. This case
stems from the resistance of Hastelloy to forming processes, and thus it is amongst
the materials that are hardest to shape. Rene 41, on the other hand, is more favorable
to form and targeted geometry can be obtained with relative ease. However, this
property makes Rene 41 vulnerable to both local and global instabilities when
subjected to excessive loads and strains.
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Figure 131: FLD Curves - Superalloys
Experimental studies indicate that each superalloy has different anisotropy. The
values of anisotropy for four superalloys are calculated after hydraulic bulge test and
presented in Table 18 [5]. Except Inconel 718, which has remarkably high anisotropy
compared to other materials, all materials behave almost as an isotropic material.
This case emphasizes necessity of special adjustment of Inconel 718 blank
geometries before trimming, instead of random blank positioning.
Table 18: Anisotropy Values - Superalloys
Material
Hastelloy
Inconel 718
Rene 41
Waspaloy

r0
1.051
0.521
0.931
0.902

r45
0.960
1.474
1.164
0.970

r90
1.044
1.137
1.078
1.198

Two different material models for Inconel 718 have been employed in the case
studies presented in Chapter 4. The main incentive behind this approach is to
illustrate the material model generation process when the exact flow curve
information is not available. The difference between various mathematical
representations of Inconel 718 are shown in Figure 132 [5]. Among the proposed
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mathematical materials models, Voce Hardening curve has the best harmony with the
experimental data.

Figure 132: Mathematical Representation of Flow Curves For Inconel 718

5 different cases were simulated in LS-DYNA® and then tested experimentally in
TUSAŞ Engine Industries, Inc. (TEI). The details of the experimental study is
presented in Table 19.

Table 19: Experimental Studies Summary
Case
1
2
3
4
5

Process Name
Deep Drawing
Rubber Forming
Radial Expansion
Deep Drawing
Rubber Forming

Materials Tested
Inconel 718, Hastelloy, Waspaloy
Inconel 718, Hastelloy, Waspaloy
Inconel 718, Hastelloy, Waspaloy
Inconel 718, Hastelloy
Inconel 718, Hastelloy
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Number of
Repetition
2
2
2
1
1

After the processes are completed, the materials were inspected with GOM-ARGUS
system which is used to measure part shape and strain distribution. Then,
experimental results were compared using SVIEW software of ARGUS system.
Comparisons show that the constructed models for each process and material are
valid. The maximum difference in major and minor strains is around 0.05, the
maximum surface deviation between experimental and virtual analysis is 0.6 mm.
The maximum thickness reduction is around 10 percent. Figure 133 to 137 show the
difference between the experimental and virtual analysis for sample cases.

Figure 133: Difference of Surface Deviation Between Experiment and Virtual
Analysis
Surface deviation for the first case is illustrated in Figure 133. The part has 340 mm
outer diameter and 43 mm height. Material of the part is Inconel 718. Since the
flange side of the part is redundant – to be trimmed later – the simulated geometry is
positioned with reference to top surface of the part. Process was simulated for a
quarter of the full model, experimental investigation was performed for the half of
123

the full model. Therefore, the gray zone in the figure can be considered as the actual
part geometry whereas the colorful zone includes simulated geometry. The highest
deviation occurs at conical surface of the part when the flange zone is excluded.
Degree of the deviation is around 0.6 mm. The frictional conditions have an
influence on strain and surface deviation, because for all simulations standart friction
coefficient was used. Nevertheless, as far as the size of the part is concerned, the
deviation quantity is acceptable.

Figure 134: The Difference of Thickness Reduction Between Experiment and Virtual
Analysis

Thickness reduction for Case 2 is illustrated in Figure 134. The part has 160.80 mm
diameter and 304.80 mm length. Material of the part is Hastelloy. The process was
simulated for the half of the actual geometry (180˚). Thickness distribution of the
actual part and the virtual model are almost the same for this case: difference is less
than 1 %.
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Figure 135: The Difference of Major Strain Between Experiment and Virtual
Analysis
Simulation steps of the third case was explained in detail in Chapter 4. The part has
394 mm diameter and 120 mm height. Figure 135 shows the results of Hastelloy
specimen. The maximum difference between experimental and virtual results of
major strain are observed at the radius zones of the formed metal and is around 0.05
mm/mm. The difference between different strains stems from the inabilities to
measure the exact positions at radius zone. On virtual analysis, radius zones have
nodes between 6-10. On the other hand, the application of regular patterns
(measurement points) is performed before the shaping process. Subsequently, after
forming, radius regions have 1-2 measurement points, which distorts the smooth
transition between points and causes different results from virtual analysis.
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Figure 136: The Difference of Minor Strain Between Experiment and Virtual
Analysis
The differences of minor strain for Case 4 (deep drawing) are shown in Figure 136.
The blank has a diameter of 596 mm before shaping. The height of the part is 33 mm
after shaping. The simulated portion of the part is 90˚, whereas the measurement is
applied for 180˚ zone. For Inconel 718 sample, the maximum difference of minor
strain between simulation result and measurement result is under 0.04 mm/mm.
Considering the huge dimensions of the workpiece, accuracy of the obtained data is
proven.
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Figure 137: The Difference of Major Strain Between Experiment and Virtual
Analysis
Case 5 illustrates a rubber pad forming process. Simulation details for this case were
given in Chapter 4. The small diameter of the part is 254 mm and the big diameter of
the part is 443 mm. The height of the part is 248 mm. Material of the part is Inconel
718. Differences of major strain between the simulated part and measurement results
are less than 0.02 mm/mm. The part has the maximum height among the studied
geometries. The result is remarkable, considering the height and the complexity of
the surface profile. Case 2 and Case 5 require special attention, since apart from
sheet metal characterization, rubber characterization have been performed as well. In
this regard, these cases can be considered as the most challenging examples of the
study presented here.
In Chapter 6, springback process was addressed in two ways:
1) Repositioning of punch/male die
2) Performing separate analysis for springback case.
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Although repositioning of punch is a plausible approach, the other members (female
die) of the simulation are not moved due to constraints defined. This situation is
problematic in terms of reliability of the results, since a complete springback analysis
requires elimination of entire forces applied on the elements. In addition, in terms of
processing cost, a separate analysis is more preferable than the former case, since
repositioning of the punch might take one fourth of the complete process (20-30
minutes) whereas running a separate simulation implicitly takes only a few minutes.
As a result, this study revealed the critical details of springback simulation as well.
Determination of boundary conditions are vital to finite element simulations, since
any discrepancy between the conditions of actual and virtual processes results in
unreasonable results. The most crucial condition for sheet metal forming processes
are motion definition. Thus, displacement – time graphs of forcing items (i.e. punch
and segments) were studied in detail. Amongst the presented cases, the case study of
expanding process in Chapter 4 have been the most challenging process, since it
required creating new coordinate systems, accurate measurements of segments’
movement, and determination of each motion components separately. In this sense,
process plan should be carefully designed and speculated to include the motion of
components before the simulation of the process is initiated.
Time spent for the simulation can be separated into two groups: the time to prepare
the simulation and time required to run the analysis. Even though the complexity of
the process gives an idea of preparation time, it cannot guarantee the duration of the
run time. The case studies covered in this thesis needed about 2 hours preparation
time on average. However, run times vary between 2 to 8 hours. The variation
between run times can pose planning problems related to launching of urgent
processes if a die optimization software or algorithm – i.e. DYNAFORM ® is not
available. Any modification of die or blank geometry between unsuccessful runs
requires repetition of the simulation steps and thereby causes increasing run times
when the optimum geometry is targeted.
The technique employed for the simulation processes are mainly based on the
construction of 3-dimensional geometries. However, as indicated in the previous
chapters, meshes were generated on surfaces only – except rubber simulation which
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necessitated tetrahedron meshes. The screening of non-contacting geometries have
facilitated construction of simulation, and more importantly have reduced the time to
run and analyze the simulation. For symmetrical parts, an improvement to this
approach would be to perform simulation on the cross section plane of the geometry.
With this method, analysis duration can be reduced to minutes – which normally
takes at least 2 hours and even more according to the complexity of the geometry.
However, section analysis cannot produce detailed results and can only be used for
rough estimations, since the anisotropy history of the material and accuracy of
geometry will be lost. Additionally, thickness, strain, surface deviation, and stress
data will not be obtained in detail.
Springback can be analyzed using LS-DYNA® as pointed out in Chapter 6.
However, LS-DYNA® cannot determine the optimum die and blank geometries for
any targeted geometry. Therefore, a sub-section – Section 6.3 - is devoted to
DYNAFORM® which can perform die optimization process. Switching between
different programs brings about additional cost to companies and extends the
simulation steps. Therefore, software updates including additional modules such as
die optimization and springback compensation would facilitate analysis procedure.
LS-DYNA® offers various meshing options for users such as solid-meshing or blank
meshing. Built-in mesh generators help the users to construct meshes automatically
and easily. However, meshing curved survaces – i.e. radius zones - require special
care in order to eliminate inaccuracies and remove probable penetration problems.
Due to aforementioned reasons, meshing cannot be performed in one single step, in
general. According to the degree of the complexity of the surfaces, meshes are
created seperately and then united. Mash unification process can also lead to
inconsistent surface normals, therefore requires manual and lengthy corrections of
normals. A special algorithm for mesh design would ease the meshing process and
carry the software to a more competitive and prestigious position among other
simulation programs.
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CHAPTER 8
CONCLUSIONS AND FUTURE WORKS
The work described in this thesis has been concerned with the development of a road
map for finite element modeling of sheet metal forming processes. The flow chart
presented in Chapter 3 was shown to be effective and robust on the modeling of deep
drawing, rubber pad forming, and radial expansion process.
A general introduction of the potential and challenges of sheet metal forming
processes was first presented in Chapter 1. With the forming processes playing an
increasingly prominent role in the aircraft and automotive industry, the problem of
determining optimal die geometry has become important. Facilitating an effective
and efficient method of optimization led to the main focus of this dissertation:
obtaining a road map to simulate a sheet metal forming process in LS-DYNA®.
Techniques for meshing and parameter selection become a key challenge in this
study, amongst other post-processing routines such as material keyword definition
and quantitative comparison.
A review of metal forming processes for sheet metals was given in Chapter 2.
Generally, these techniques can be divided into five main categories as: (a) forming
by pressure; (b) tensile/compressive forming; (c) forming by tensile forces; (d)
forming by bending and (e) forming by shearing. Some of these classes had subcategories that further distinguish the methods.
In Chapter 3, LS-DYNA® software was introduced. A detailed description of the
keywords was presented. Additionally, the steps to construct a model in LS-DYNA®
was illustrated with the aid of a flow chart.
Development of the models and simulation files was proposed and detailed in
Chapter 4. In this chapter, three different case studies were investigated: deep
drawing simulation, rubber forming simulation, and radial expansion simulation.
In Chapter 5, the steps required to extract the results of a successfully run analysis
was provided.
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Chapter 6 focused on the springback concept and the 2 ways to simulate this
phenomenon was provided. Additionally, springback compensation tool of
DYNAFORM® was introduced.
Chapter 7 provided experimental results pertaining to 5 cases and quantitative
assessment to validate the performance of the algorithm.
This work has unified the ideas of using finite element models with the experimental
results of superalloy materials. The advantage of employing a model with some prior
knowledge is useful in terms of the reliability of the study. However, evaluations
have shown that several problems appear to restrict the performance of the program.
Limitations on success were mainly due to the motion definition; the processing time
of the analysed model, which provided insufficient prior information for the model
during modeling phase.
Although the results presented here have demonstrated the effectiveness of the
approach, it could be further developed in a number of ways:
-

The constructed models were in 3-D. However, employing 2-D models might
be a better and faster approach in terms of time point of view.

-

The code in order to optimize the die geometries will be a distinguished
approach in terms of both time and cost optimization.

-

Generally, radius of the formed sheets is not critical to quality requirements.
However, the difficulty of meshing the radius zones of dies should be
overcome for critical parts, and that may require a new algorithm for the
software.
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